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1
Getting started
The HeartStart Telemedicine System (Telemedicine) is part of an endto-end Telemedicine solution for communicating patient data from the
HeartStart MRx Monitor/Defibrillators (HeartStart MRx) to a viewing and
forwarding workflow station. On the sending side, the HeartStart MRx
can be configured to transmit 12-lead ECG reports (12-lead reports),
periodic clinical data, and waveform data when trigger events occur.
If you are new to Telemedicine, read the following topics to learn about
the product and how it is used:
•

Who uses Telemedicine on page.8

•

How Telemedicine is used on page.8

Learn how information is presented in this guide by reviewing the
following topics:
•

How this guide is organized on page.18

•

Conventions used in this guide on page.20

Philips recommends that you review this entire guide before you begin
to install or use Telemedicine.

New in this release
This version of the HeartStart Telemedicine System user guide has been
reorganized from previous versions.
You can save up to 50 Auto Send Lists. Each Auto Send List can contain
up to 20 destinations.
Additional configuration parameters are added for connecting to the
SMTP server, allowing direct connections to corporate, ISP, or internet
SMTP servers.
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Intended use of Telemedicine
The Telemedicine software displays patient vitals, waveforms, and 12lead ECG information transmitted from Philips HeartStart defibrillators
in remote locations. The Telemedicine Server software allows viewing,
diagnostic-quality printing, archiving, and further distribution of
digitized clinical data. The Telemedicine Server software is also able to
forward the 12-lead ECG data to compatible ECG management systems
such as TraceMasterVue.
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Who uses Telemedicine
Telemedicine is typically configured in one of the following
environments:
At an EMS agency that serves multiple hospitals for a region
In this environment, the software commonly runs on one computer in a
server room at the EMS agency. Telemedicine forwards 12-lead reports
to receiving hospitals using fax, email, or other instances of
Telemedicine that are installed at one or more hospitals. An Auto Send
List can be used to notify a hospital at a number of fax or email
destinations.
In a hospital that is served by multiple EMS agencies
In this environment, the software commonly runs in an IT server room
with multiple copies of Telemedicine Viewer running in departments
such as ED, Intensive Care Unit, Cardiology, or Radiology. Sometimes,
these hospitals also forward the 12-lead reports automatically to their
ECG Diagnostic Cardiology databases, such as TraceMasterVue or a GE
MUSE System (GE MUSE).
In a hospital where HeartStart MRx Monitor/Defibrillators are
used to monitor patients
In this environment, HeartStart MRx Monitor/Defibrillators are used in
chest pain rooms, overflow areas, or as transport monitors.
Telemedicine runs at a central nurses' station, allowing centralized
viewing and printing of the 12-lead reports from HeartStart MRx
Monitor/Defibrillators. Clinicians can also forward the 12-lead reports to
the cardiology department.

How Telemedicine is used
Users in different healthcare markets use Telemedicine in different
ways, based on their unique workflow and existing infrastructure. For
example, an organization can use Telemedicineto do the following:
•

Provide critical-care support to responders on an inbound ambulance
who are transporting a patient to the emergency department (ED).
You can view periodic clinical data (12-Lead reports, trigger events
with waveforms, and vital trends) while responders transport a
patient to the receiving emergency department or hospital.
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Prepare an Emergency Department for the arrival of a critical-care
patient.
You can triage a patient who is in route to the ED, access a patient's
medical history, make decisions about where to assign a patient, or
summon specialists in advance of the patient's arrival.

Telemedicine system receiving HeartStart MRx periodic clinical data at a
central station

Telemedicine can be used to prepare for the next level of care inside the
hospital.
Some examples (refer to the previous image):
•

Emergency departments locate HeartStart MRx
Monitor/Defibrillators in chest pain rooms or in overflow locations
(1) and forward 12-lead reports for use in a department such as
Cardiology (2).
The Telemedicine System can receive HeartStart MRx 12-lead
reports at a central station (1) and forward them to a TraceMaster
ECG management system (TraceMasterVue) and to an ECG host such
as GE MUSE in Cardiology (2), or to an IntelliVue information
console (3) at another location.
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Hospitals locate the Telemedicine System in a central location in the
hospital, or in the emergency department.
From the Telemedicine computer, you can manually select clinical
data and fax or email the data to another department such as
Surgery, Radiology, or the ICU. You can also manually print the
patient report on a printer that is at another location in the hospital.
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Sample workflows
The following sample workflows are provided for learning purposes.
Your usage may differ from these workflows.
Example workflows for clinicians and medical staff
Scenario

Task

Topic

EMS responders are sending the HeartStart
MRx data transmissions for you to assess.

View patient data

Review Using the
Patients workspaces
on page.47.

Change the way
Review Using Report
information appears in Preview on page.54,
a patient report
and Working with data
tables on page.42.
The ED medical staff receives a patient
transmission and needs to send it to a
physician at a different location on the
network.

Forward the
HeartStart MRx
patient data

See How Telemedicine
forwards HeartStart
MRx data on page.31.

During your shift, you did not receive all the
patient data. You want to search for patient
data transmissions that were not complete.

Review the system log See Working with the
system log on
page.69.

Example workflows for IT personnel
Scenario

Task

Topic

IT personnel need to set up the Telemedicine
system hardware and software.

Configure
Telemedicine Server
(and Telemedicine
Viewer, if applicable)

Use Administration of
Telemedicine on
page.70 as a
reference.
Review the entire User
Guide, starting with
Getting started on
page.6 and Overview
of Telemedicine
software on page.21.
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Scenario

Task

Topic

After installing the Telemedicine System, your
Medical Director gives your IT personnel
information about the destinations that will
receive the patient data transmissions.

Configure destinations See Configuring
for patient data
destinations on
page.103.

Medical staff needs to access patient data
stored in another Telemedicine System on the
network.

Connect to a different
Telemedicine System
on the network

See Configuring the
Telemedicine Viewer
on page.117

You receive the HeartStart MRx data on a data
card and need to add it the Telemedicine
database.

Import the HeartStart
MRx patient data to
the Telemedicine
database from a data
card

See Importing
HeartStart MRx 12lead reports from a
data card on page.66.

Your Medical Director sent you an email that
lists changes to the Auto Send List
destinations.

Edit Auto Send Lists

See Editing or deleting
Auto Send Lists on
page.115.

You received an email stating that several
printers and fax machines were upgraded. You
need to change several destinations and Auto
Send Lists.

Edit printer, fax, and
Auto Send List
destinations

See Setting up for
printing 12-lead
reports on page.111
and Add, edit, or
delete fax destinations
on page.107. Also see
Editing or deleting
Auto Send Lists on
page.115.

You received an email stating that the
database is reaching its storage capacity. You
need to archive and delete patient data to
provide storage space.

Delete patient data

See Backing up your
data on page.84, and
Deleting patient data
on page.67.

Set up Auto Send Lists See Setting Up Auto
Send Lists on
page.112.
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System requirements
Confirm that your hardware and software meet the following minimum
system requirements.
The entries in the following tables are requirements unless they are
labeled as recommendations, or unless a choice is provided.
These requirements are included in this topic:
•

Software requirements on page.13

•

Hardware requirements on page.13

•

Accessories on page.14

Software requirements
Component

Requirements

Operating system for
Telemedicine Server

Microsoft Windows Server 2008 R2*
-orMicrosoft Windows 7*
* Running with the corresponding Microsoft
Internet Information Service (IIS)

Operating system for
Telemedicine Viewer

Microsoft Windows 7

Database server software
for Telemedicine Server

Microsoft SQL Server 2008 R2 Express Edition
that can store up to 10 GB of data
NOTE: The Microsoft SQL Server software is
installed automatically with the Telemedicine
Server software.

Hardware requirements
Component

Requirements

Processor speed for
Telemedicine Server and
Telemedicine Viewer

Minimum: 1 GHZ or higher

Display

Minimum: 1024 x 768
Recommended: 1280 x 1024 or higher

Memory for Telemedicine

Minimum: 2 GB
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Requirements

Server
Memory for Telemedicine
Viewer

Minimum: 1 GB

Disk storage space for
Telemedicine Server and
Telemedicine Viewer

20 GB of available disk space for database storage
NOTE: Hard-disk space requirements vary
depending on usage. Variables affecting disk
space requirements include the number of
HeartStart MRx patient cases archived and the
number of years to store data. Philips
recommends that you back up your data and
store the data at an offsite location.
For more information, see Data storage
requirements on page.101.

Internet connection for
Telemedicine Server and
Telemedicine Viewer

Required

Telephone line for
Telemedicine Server

Analog telephone line
To send faxes

Accessories
Component

Requirements

PDF Reader for
Telemedicine Server and
Telemedicine Viewer

Recommended: Adobe Reader, latest version. For
more information, see the following Web site:
www.adobe.com
To view the HeartStart Telemedicine System
user guide.

Backup-and-restore tool for
Telemedicine Server

To prevent data loss

Email application for
Telemedicine Server

Recommended: SMTP server or relay
To send email through an Auto Send List
Recommended: Microsoft® Outlook or
Microsoft® Outlook Express
To activate the software using email, or to send
patients using email, configure a MAPI-compliant
email client.
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Component

Requirements

Email application for
Telemedicine Viewer

Recommended: Microsoft® Outlook or
Microsoft® Outlook Express
To activate the software or to send patient data
using email, configure a MAPI-compliant email
client.

Fax modem for
Telemedicine Server

Recommended

Printer for Telemedicine
Server and Telemedicine
Viewer

To print 12-lead and periodic vital trends reports

Bluetooth® adapter for
Telemedicine Server

To transfer the HeartStart MRx patient data
using Bluetooth wireless transfer

Bluetooth stack for
Telemedicine Server

Bluetooth Version: 1.1 or higher

To fax 12-lead and periodic vial trends reports

•

Widcomm Bluetooth stack

Note: You can use any Bluetooth stack
supported for the HeartStart MRx. See the
HeartStart MRx M3535A/M3536A instructions
for use.
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Recommended IT skills
Philips recommends that information technology (IT) personnel with the
following skills set up your Telemedicine system.
Implementation tasks and skills table
Task

Skill Level

Set up
networks

Understand basic networking, and the theory for the
following:
•

Internet Information Services (IIS)

•

SQL (must be able to install and configure SQL
Server 2008 R2)

•

Cellular telephony, including dial-up networking,
data tethering, and mobile data applications

•

SMTP servers (email), including SMTP command set

•

Firewalls

•

Proxy servers, including HTTP proxy (HTTPS proxy)

•

Faxing technology

•

Internet Service Providers (ISP)

•

Domain names

Identify
application
requirements

Familiarity with the HeartStart Telemedicine System
user guide (before beginning the implementation)

Set up servers,
and services

Experience setting up Web server and Windows Service
Controller

Set up HTTP
connectivity

Experience implementing the HTTP connection

Set up data
card
connectivity

Experience setting up data-card adapters

Set up
Bluetooth
connectivity

Experience installing and setting up Bluetooth software
and adapters

Test and
Understand the troubleshooting process, and have
troubleshoot
experience with the following:
the
implementation • Knowledge of the data transmission methods from
HeartStart MRx to Telemedicine
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Skill Level
For more information, see the "Working with
defibrillators" section in the HeartStart MRx
M3535A/M3536A instructions for use.
•

Experience troubleshooting an IIS server

•

Experience troubleshooting security issues, such as
firewalls, antivirus software, authentication, and
encryption

•

Experience troubleshooting networks
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How this guide is organized
This guide is primarily for the everyday users of Telemedicine. These
are users who view the patient data received by Telemedicine,
supplement this data with demographic information, and forward this
data. Forwarding patient data includes printing, faxing, and emailing
reports, as well as forwarding data to a computer running another
software application, or another Telemedicine Server.
Material in the "Administration of Telemedicine" section is for the IT
personnel who install the Telemedicine software, configure the system
for the display and forwarding of patient data, maintain the system, and
administer the database.
This guide is available as a PDF document that you can view and search
on your computer, and that you can also print. In that document, you
can view the overall organization of the guide in the table of contents,
and then click a topic to go directly to that information. To open a PDF
file of the user guide, on the Help menu, click User Guide.
The information is also provided as online help from within the software.
See Using online help on page.20.
This version of HeartStart Telemedicine System user guide has
been reorganized from previous versions.
Section summary
1. This section, "Getting started," provides essentials such as system
requirements, the formal Intended Use Statement, and an
introduction.
2. Overview of Telemedicine software on page.21 assists all readers in
understanding the Telemedicine products and the environments in
which they are used.
3. Everyday use of Telemedicine on page.39 is directed to the everyday
users of Telemedicine. This section introduces working areas and
provides procedures for viewing and forwarding data.
Philips strongly recommends that the installation, configuration,
and maintenance of your Telemedicine system, and the
administration of the Telemedicine database, be done by
experienced IT personnel.
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4. Administration of Telemedicine on page.70 is directed to IT
personnel. This section contains information about installing the
software, configuring the system, setting up communication with the
peripheral devices and other computers, and maintaining the
Telemedicine system and database.
5. Implementation supplement—Using Telemedicine with Data
Messenger on page.122 provides IT personnel with technical
information about configuring Data Messenger and Telemedicine to
work together, so that they can communicate HeartStart MRx data to
Telemedicine.
6. Customer support on page.141 provides you with telephone,
Internet, and email contact information for getting product and
technical support.
7. The Glossary on page.145 gives definitions for terms and acronyms.
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Conventions used in this guide
This document uses the following conventions to help identify
information.
A yellow box with a triangular caution icon and exclamation mark
identifies circumstances that can result in data corruption or
information loss.
A blue box with a note icon contains information on how features
are used.
A green box with a light-bulb-tip icon contains information to
complete a task.

Using online help
Use the online help system to search for information using the full-text
search feature, the glossary, or the index.
You can access online help in these ways:
•

Press F1 to open online help.

•

On the Help menu, click Telemedicine System Help

20
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Overview of
Telemedicine
software
The Telemedicine System consists of two software applications, the
Telemedicine Server and the Telemedicine Viewer.
The Telemedicine Server is the essential piece of the system, and the
Telemedicine Viewer is an optional addition.
With Telemedicine System software you can receive, store, display, and
forward patient data transmitted from HeartStart MRx
Monitor/Defibrillators. The patient data Telemedicine receives from the
HeartStart MRx consists of periodic clinical data (12-Lead reports,
trigger events with waveforms, and vital trends).
The Telemedicine Server software
The Telemedicine Server software is available in two editions. These
editions vary from each other in the HeartStart MRx patient data that
they store, display, and forward.
•

Telemedicine Classic 12-Lead Edition stores, displays, and
forwards 12-lead reports.

•

Telemedicine Critical Care Edition stores, displays, and
forwards 12-Lead reports, trigger events with waveforms, and vital
trends.
These editions are licensed separately. The same software
download becomes either Telemedicine Classic 12-Lead Edition or
Telemedicine Critical Care Edition, depending on the license key
entered.
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The Telemedicine Viewer software
Telemedicine Viewer is an optional component, used with the
Telemedicine Server. The Telemedicine Viewer is installed on a different
computer from the Telemedicine Server. It allows users to interact
remotely with, and perform tasks on, the patient data on the
Telemedicine Server.
You can use Telemedicine Viewer with either the Telemedicine Classic
12-Lead Edition or Telemedicine Critical Care Edition of the
Telemedicine Server.
Each copy of Telemedicine Viewer is licensed separately.
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The Telemedicine System illustrated
You can configure the Telemedicine System in many ways, depending on
your needs.
A high-level view of capabilities for a Telemedicine System

Telemedicine System elements
1

Bluetooth wireless communication

2

Cell phone forwards data to Telemedicine

3

Firewall between the outside world and the Telemedicine Server

4

HeartStart MRx data through Data Messenger to Telemedicine
NOTE: There are multiple options for setting up Data Messenger between the
HeartStart MRx and Telemedicine. For setup information intended for IT
personnel, see Implementation supplement—Using Telemedicine with Data
Messenger on page.122, or contact customer support for more information.

5

Internet

6

Data saved to a folder on a computer
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7

Data sent to a printer

8

Data sent to a fax machine

9

Data sent by email

10

Data forwarded to another instance of Telemedicine

11

Data forwarded to another ECG management system, such as TraceMasterVue

12

Telemedicine Server

13

Intranet or Internet

14

Setup for communication between HeartStart MRx devices and Telemedicineis
represented in this portion of the workflow

15

Everyday use, and administration for everyday use, is represented in this portion
of the workflow

Philips strongly recommends that the installation, configuration,
and maintenance of your Telemedicine System be done by
experienced IT personnel.
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How HeartStart MRx data is
transferred to Telemedicine
This section describes how data is transmitted from the HeartStart MRx
to Telemedicine.
The following steps describe the process of sending an automatic
transmission from the HeartStart MRx.
1. If it has not been done already, the operator configures a Bluetooth
device (a cellphone or computer) and pairs it with the HeartStart
MRx.
2. The operator selects Start Data Transmission on the HeartStart MRx,
and selects the Bluetooth device for the PCDT transmissions.
3. The HeartStart MRx shows the Bluetooth icon indicating the
automatic transmission mode, and sends out the "startPCDT" event.
4. The HeartStart MRx encrypts and transmits the following data
automatically:
•

Vital trending values, every 1 to 5 minutes, as set in the
configuration

•

Event data and the associated waveform data, when a trigger
event occurs

•

If a 12-lead is acquired, 12-lead data, after the analysis is
complete

5. When Telemedicine receives data from the HeartStart MRx, it
decrypts and decodes the data, and then stores the data in the
Telemedicine database.
6. Telemedicine then forwards the data, as set up in the Auto Send List.
7. Telemedicine also displays the data in the Telemedicine Viewer.
8. The operator selects End Data Transmission on the HeartStart MRx,
causing the HeartStart MRx to send out the "endPCDT" event and exit
the automatic transmission mode.
The following steps describe the manual transmission of data from the
HeartStart MRx to Telemedicine.
Only the HeartStart MRx 12-lead data can be transmitted manually.
1. If it has not been done already, the operator configures a site, hub,
or destination for transmission.
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2. The operator ensures that the HeartStart MRx is not in PCDT
automatic transmission mode.
3. The operator sets the HeartStart MRx to 12-lead mode.
4. The HeartStart MRx acquires 12-lead data.
5. The operator selects Send from the HeartStart MRx menu, and then
selects the destination for the transmission. The transmission is
sent.
6. When Telemedicine receives the 12-lead data from the HeartStart
MRx, it decrypts and decodes the data, and stores the data in the
Telemedicine database,
7. Telemedicine then forwards the data, as set up in the Auto Send List.
You can also use a data card to manually transfer the HeartStart MRx
12-lead data. For a description of this process, see Importing HeartStart
MRx 12-lead reports from a data card on page.66.
Technical procedures for the IT personnel setting up the communication
between the HeartStart MRx and Telemedicine are provided in
Implementation supplement—Using Telemedicine with Data Messenger
on page.122.
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HeartStart MRx periodic clinical data
In a periodic clinical data transmission (PCDT), 12-Lead and vital data is
transmitted automatically, and trigger event data is sent when a preconfigured trigger event happens. A trigger event initiates a HeartStart
MRx data transmission.
The following table identifies trigger events and the data that the
HeartStart MRx sends to Telemedicine and other destinations.
All transmissions between the HeartStart MRx and Telemedicine are
encrypted. Transmitted data may contain personal patientidentifiable data. Be sure to handle this data in accordance with the
patient privacy requirements of your organization, and with
applicable local laws such as HIPPA.
For more information about HeartStart MRx trigger events, see
HeartStart MRx M3535A/M3536A instructions for use.
Trigger events
Event

When

What data is sent

Vital signs updated

Every 1 to 5 minutes
(based on the interval
configuration on the
HeartStart MRx)

Patient vital data for pulse, heart and AwRR
rates, NBP, EtCO2, SpO2, invasive
pressures and temperature for the
parameters that are turned on; timestamp
of vitals
HeartStart MRx device ID
HeartStart MRx incident ID

12-lead acquired

When acquired

12-lead ECG (may include ACI-TIPI and TPI
information)
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Event

When

What data is sent

Mark Event

When Mark Event
button is pressed on
the HeartStart MRx

All data with vital signs update

(When a label is
added, this is an
Annotation Event)

Event label and time
Mark event description
Note: If a label is not selected within five
seconds of pressing the Mark Event button
on the HeartStart MRx, the event is labeled
as generic and sent.
A segment consisting of the 10 seconds
before and the five seconds after the Mark
Event, inclusive, for each of the waveforms
configured to be printed

Delivering a shock

After shock is
delivered or aborted
due to impedance or
other issues

All data with vital signs update
Event label and time
Shock number*
Number of Joules*
Data on impedance and peak current*
A segment consisting of the 10 seconds
before and the five seconds after the
shock, inclusive, for each of the waveforms
configured to be printed
* Not sent with an aborted-shock PDT

Pacing change

When pacing is
started, stopped, or a
pacing control is
changed (mode, rate,
or output)

Event label and time Pacer mode (Fixed or
Demand), rate, and output
A segment consisting of the 10 seconds
before and the five seconds after the
pacing change, inclusive, for each of the
waveforms configured to be printed
Note: Stop pacing does not transmit
pacing mode, rate, or output

Physiological alarms** When trigger event
occurs

Event label and alarm condition with Vital
signs update.
A segment consisting of the 10 seconds
before and the five seconds after the
alarm, inclusive, for each of the waveforms
configured to be printed
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Event

When

What data is sent

Print Event

When Print button is
pressed

All data with vital signs update

When trigger event
occurs

Note: End PCDT does not send vitals or
waveform data

Start/End PCDT

A segment consisting of the 10 seconds
before and the five seconds after the
alarm, inclusive, for each of the waveforms
configured to be printed

** Physiological alarms: Asystole, VFIB/VTACH, VTACH, Extreme Tachy, Extreme Brady, Apnea, Extreme
Desat, Invasive Pressure Disconnect, PVC/min high, Pacer Not Captured, Pacer Not Pacing, Pacer Output Low
and alarm limits for HR, NBP, EtCO2, SpO2, Pulse rate, AwRR, Invasive Pressure, CPP, and Temperature

How Telemedicine inboxes process
12-leads and periodic clinical data
The Telemedicine inboxes are installed on the Telemedicine Server
computer. The inboxes receive the data from the HeartStart MRx or
another instance of Telemedicine. The Telemedicine Server stores the
original data files in the backup folder.

Default installation directories for Telemedicine Inboxes
TSInbox
C:\Program Files\Philips\HeartStart\Telemedicine\TSInbox
TSInbox receives 12-lead reports forwarded from other instances of
Telemedicine System or 12-Lead Transfer Station.
MRxInbox
C:\Program Files\Philips\HeartStart\Telemedicine\MRxInbox
MRxInbox receives all HeartStart MRx 12-lead reports.
TSXInbox
C:\Program Files\Philips\HeartStart\Telmedicine\TSXInbox
TSXInbox receives all Bluetooth transmissions.
PatientDataInbox
C:\Program Files\Philips\HeartStart\Telemedicine\PatientDataInbox
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PatientDataInbox receives periodic clinical data transmissions from the
HeartStart MRx.
PDTSInbox
C:\Program Files\Philips\HeartStart\Telemedicine\PDTSInbox
PDTSInbox receives periodic clinical data transmissions forwarded from
another instance of Telemedicine.
The Inbox Watcher Service monitors the inboxes and checks for activity.
There is a backup folder in each inbox. After original data is processed
by the Inbox Watcher Service, it is saved to a backup folder in the
corresponding inbox.
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How Telemedicine forwards
HeartStart MRx data
In Telemedicine, the HeartStart MRx data can be forwarded
automatically or manually. The type of HeartStart MRx data that you can
forward depends on the software option that your organization installed
and the destinations set up for your organization.
This is an overview of what data can be forwarded.
For instructions on how to forward data, see Forwarding patient data on
page.63.
•

Telemedicine Classic 12-Lead Edition can store, display, and forward
only 12-lead reports to configured applications, email addresses, fax
machines, and printers. Telemedicine can forward the 12-lead
reports automatically, or you can forward them manually.

•

Telemedicine Critical Care Edition, in addition to Telemedicine
Classic 12-Lead Edition functionality, can store, display, and forward
periodic clinical data transmissions. A transmission can be a 12-lead
report, a trigger event and waveform, or vital trends. You can use
Telemedicine on one computer to manually forward trigger events,
waveforms, and vital trends to Telemedicine on another computer.
You can also print a report, send a fax, or email periodic clinical data
to an alternate destination.

Forwarding data automatically, in an Auto Send List
An Auto Send List can forward a 12-lead report automatically. An Auto
Send List can include the following destination types:
•

HeartStart 12-Lead Transfer Station 3.0

•

TraceMasterVue

•

DatamedFT

•

Telemedicine

•

Fax machine

•

Email address

When forwarding a transmission to an email address, you can
password-protect the email.
Telemedicine uses the printers that are set up for your network.
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Forwarding data manually
You can use the Forward options on the File menu to send the following
selected data manually:
•

Patient record to a configured Telemedicine destination.

•

Patient 12-lead report to a configured destination.

•

Transmission of trigger event or periodic vital trends to a configured
Telemedicine destination.

•

Patient record to an alternate fax machine, printer, or email
address. A selected patient record can contain 12-lead reports, and
periodic vital trends.

Use the Fax 12-Lead, Print Report, and Email PDF options on the File
menu to send the selected patient record or transmission to another
destination.
The following table lists the kinds of patient data transfer that are
supported by the two Telemedicine Server editions, Classic 12-Lead and
Critical Care. For more information, see Overview of Telemedicine
software on page.21.
Supported patient data transfer, by edition
HeartStart Telemedicine
Classic 12-Lead
Edition

Critical Care
Edition

Automatically forward 12-lead
reports through an Auto Send
List

Yes

Yes

Manually forward a selected
patient record

No

Yes

Manually forward a selected 12lead report

Yes

Yes

Manually forward a selected
trigger event and waveform

No

Yes

Manually forward vital trends for No
a selected patient record

Yes

Fax a selected 12-lead report

Yes

Yes

Print a Patient Report for a
selected patient record

No

Yes

Print a selected 12-lead report

Yes

Yes

Task
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Print a selected waveform

No

Yes

Print vital trends for a selected
patient record

No

Yes

Email a PDF of a Patient Report
for a selected patient record

No

Yes

Email a selected 12-lead report

Yes

Yes

Email a selected waveform

No

Yes

Email vital trends for a selected
patient record

No

Yes

Export a Patient Report for a
selected patient record

No

Yes

Export a selected 12-lead report

Yes

Yes

Export a selected waveform

No

Yes

Export vital trends for a selected No
patient record

Yes
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Introducing the application window
When you start Telemedicine, the navigation pane is on the left, Getting
Started is at the top, and the Welcome screen is on the right.
The Welcome screen identifies the installed Telemedicine version
(Telemedicine Server or Telemedicine Viewer), and the edition (Classic
12-Lead or Critical Care).
On the Welcome page the Introduction link opens the application help
file.The other two links, Visit the HeartStart Telemedicine Server Web
Site and Check for Software Updates, require an Internet connection.
The title bar displays the version of the application, Telemedicine Server
or Telemedicine Viewer. Beneath the title bar, menus appear across the
top of the window, and a toolbar with buttons appears below the menus.
Menu options and toolbar buttons change based on the navigation
button and the function that you select.
•

The menus list options to access the application features.

•

The toolbar buttons provide quick access to frequently used menu
options.

Beneath the menus and toolbar buttons, the navigation pane is on the
left and the workspaces are on the right.
For complete instructions about controlling the navigation pane, see
Using the navigation pane on page.40. A brief summary follows.
•

The navigation buttons are Getting Started, Patients, and
Administration. The navigation pane is the area above the navigation
buttons. This area groups major application features by function.
The navigation pane takes on the identity of the currently selected
navigation option. For example, when you click the Administration
navigation button, the Administration navigation pane appears.
Click Hide
to hide the navigation buttons and the navigation
pane, creating more space in which to view patient data. When
navigation buttons are hidden, their icons persist on the top left
window edge. Click an icon for a navigation button to display that
specific navigation pane.

The navigation icons and the navigation panes they represent
Getting Started
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Patients
Administration
To redisplay all the navigation buttons, click Display
in the upper
right corner of an individual open navigation pane. The navigation
pane with all the navigation buttons reappears on the left side of the
window.
•

The workspaces are on the right side of the window. A workspace
can contain one or more panes, depending on the function you
select.
The workspaces change appearance based on the navigation button
and the feature that you select. For example, if you click the Patients
navigation button, and click View All Patients, the View All Patients
workspace appears on the right.
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Viewing patient data in Telemedicine
You can use the Patients feature to view patient 12-lead reports and
periodic clinical data that the HeartStart MRx records and transmits.
The Telemedicine software option and the HeartStart MRx options that
you purchased determine the types of HeartStart MRx patient data that
Telemedicine processes and stores.
Telemedicine Classic 12-Lead Edition
Stores, displays, and forwards 12-lead reports. The 12-lead
reports can be viewed in the View Patient work area, and
viewed, printed, or exported from the Report Preview window.
Telemedicine Critical Care Edition
Stores, displays, and forwards 12-lead reports plus periodic
clinical data. Periodic clinical data can include trigger events,
waveforms, and periodic vitals.
Telemedicine Viewer
Depending on the version of Telemedicine Server that it is
connected to, Telemedicine Viewer displays data from a remote
location, either Telemedicine Classic 12-Lead Edition or
Telemedicine Critical Care Edition.
For a reference to trigger events, see HeartStart MRx periodic clinical
data on page.27.
Depending on how the HeartStart MRx is configured, the HeartStart MRx
might send the following clinical data:
•

12-lead reports to Telemedicine, automatically or manually

•

Periodic vitals to Telemedicine in 1- to 5-minute intervals,
automatically

•

Trigger event data, when triggered
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The Patients navigation area and Patients workspace

This screen illustrates the Patients navigation area (1) and the Patients
workspaces (2).
The Patients navigation pane (1) lists patient information in the
order that Telemedicine receives the HeartStart MRx data
transmissions.
On the Patients navigation pane (1), below the Patients button, the
View All Patients button and the View Latest Patient button control
what appears in the Patients workspace, to the right.
The Patients workspace (2) makes up the right side of the screen,
which is divided into panes. The information appears differently
depending on selections users make.
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In the Patients navigation pane (1), if the View All Patients button is
clicked, the Patients workspace (2) shows the View All Patients list,
with information for each patient. The list columns are configurable,
and may include patient ID, the transfer method, institution, status,
and other details, (not illustrated here; see Viewing all patients on
page.48).
In the Patients navigation pane (1), if the View Latest Patient button
is clicked, the Patients navigation pane (1) lists transmission details
about the selected patient. On the right, in the Patients workspace
(2), up to four panes appear:
•

The Transmissions pane (3) displays all the transmissions for the
selected patient and a brief description of each transmission
type.

•

The Waveform pane (4) to the right of the Transmissions pane,
at the top of the screen, displays trigger events and waveforms,
if the patient data includes a waveform.

•

The 12-Lead pane (5), below the Waveform pane, displays 12lead ECG reports.

•

The Vital Trends pane (6), below the 12-Lead pane, displays the
periodic vitals for the patient, in a table or chart format.

The Waveform pane (4) and the Vital Trends pane (6) exist only in
Telemedicine Critical Care Edition.
On Telemedicine Viewer, the HeartStart Telemedicine Server field
(7) is located in the lower right corner of the screen. The field
shows the name of the database, and contains the Change Server
selection, which is used to connect Telemedicine Viewer to a
Telemedicine Server database.

Viewing the system log
You can view the system log to see the status of all Telemedicine
activity.
To view Telemedicine activity in the system log
1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click System Log.
The system log appears.
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Everyday use of
Telemedicine
This section is intended for users who work with patient data. This
section tells you how to use the Telemedicine application to view patient
data, format patient reports, and transfer patient data to destinations.
For information about installing and configuring Telemedicine, see
Administration of Telemedicine on page.70.

Starting Telemedicine
The Telemedicine installation does not place an icon on your desktop.
Use the Windows menus as described to open Telemedicine.
The features you see when you log on to Telemedicine depend on
whether you log on to the Telemedicine Server or the Telemedicine
Viewer.
•

On the Telemedicine Server, configuration features are available on
the Administration pane.

•

On the Telemedicine Viewer, there are no configuration features on
the Administration pane.

To start Telemedicine
1. On the Windows desktop, click Start.
2. Click All Programs.
3. Click Philips HeartStart Telemedicine System.
4. Click Telemedicine.
The application opens, with the Getting Started navigation button
activated. The Getting Started navigation pane and workspace
appear.
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The first time you start the application, Telemedicine displays the
Philips HeartStart Activation Wizard. Telemedicine keeps track of
the number of days before the preregistration period expires.
Telemedicine stops working if you do not activate the software
within 60 days of installation. For information about activating
Telemedicine, see Activating Telemedicine on page.73.

To use Telemedicine
To use Telemedicine, start by clicking a navigation button on the left
pane of the application window. Make your selection based on what you
want to do.
Getting Started is the default view when you first start, and it offers
general information useful to Telemedicine users.
Patients is where your work with patient data is performed.
Administration is where IT personnel find the tools to set up and
maintain the Telemedicine system.

Using the navigation pane
The navigation pane provides centralized navigation and access to the
application features.
Each navigation button opens a pane with access to features.
To display a set of features, grouped by function, click one of the
navigation buttons.
The following icons and labels represent the main navigation buttons:

•

Getting Started helps you to learn about Telemedicine, visit
the Telemedicine Web site, and look for software updates.

•

Patients has tools to import and view the HeartStart MRx
data. Use Patients to review and forward the HeartStart MRx data.

•

Administration helps you configure the Telemedicine System,
destinations for patient data, and Auto Send Lists. You can also
monitor and troubleshoot system activity.
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There are additional navigation panes on the Patients navigation pane,
and also on the View Patient workspace. You can hide the navigation
panes to increase the size of each workspace. You can return to a
navigation pane while you work on the set of features.
To hide the navigation pane
•

At the top of the navigation pane, click Hide

.

Telemedicine hides the navigation pane and displays a tab along the
left edge of the window, with icons for the navigation areas.
To temporarily display a navigation pane
1. Point to a tab icon along the left edge of the window.
Telemedicine temporarily displays that navigation pane.
2. Telemedicine hides the pane when you point to or tap the right
pane.
To restore the navigation pane
•

Point to a tab icon along the left edge of the window to expand a
navigation pane, and then click Display

on the navigation pane.

All the navigation buttons appear at the bottom of the navigation
pane.
By default, Telemedicine displays all navigation buttons.
You can display or hide navigation buttons on a navigation pane.
To show fewer or more navigation buttons
1. On the navigation pane, click the drop-down button on the
bottom navigation button.
2. On the menu, click the appropriate button:
•

Click Show Fewer Buttons to hide the navigation button
and display the icon on the bottom navigation button.

•

Click Show More Buttons to restore the navigation button.

•

Click Add or Remove buttons, and then click the button
you want to remove or return to the navigation pane. For
example, click Getting Started to hide the Getting Started
navigation button.

3. Repeat steps 1 and 2 for each navigation button that you want to
change.
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If you hide all the navigation buttons, the options are still available
for selection as small icons below the navigation pane. A tooltip
appears when you point to an icon on the bottom navigation button.

Resizing panes and workspaces
You can change the default layout of the Telemedicine window.
Telemedicine displays your layout the next time you use the navigation
pane or workspace.
To resize a pane or workspace
1. Use the mouse to click and hold a border on the pane that you want
to resize.
2. Drag the border in the appropriate direction to a new location.
Telemedicine adjusts the size of the adjacent panes.

Restoring the default view
From the Patients workspaces, you can restore the default (as-installed)
layout of the Telemedicine application window.
To restore the default layout, on the View menu, click Default View.
Telemedicine restores the navigation panes, navigation buttons, and
workspaces to the default layout.

Working with data tables
Telemedicine displays data in configurable tables. You can control how
the data appears in the tables.
•

The Patients table

•

The View All Patients table

•

The Transmissions table

•

The System Log table
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Working with columns
You can customize the columns that appear on the table. You can resize
the width of a column. You can also hide or display the columns on the
table and the order in which they appear.
•

To change a column width, click and hold the column border, and
then drag the border to the size you prefer.

•

To size a column to fit the width of its current content, click the
column border, and then double-click the mouse.

•

To change the order in which columns appear, click and hold the
column header, and then drag the column to the left or right to a new
location.

To hide or display the columns on the table
1. Right-click a column header name to display a shortcut menu.
2. Click Columns to display a list of column header names.
3. Click a check box for each column that you want to hide or display on
the table.
Column headers with a check mark display on the table.

Sorting entries
You can sort the information by the column. A triangular symbol appears
on the column header to indicate sort order. Click the symbol to reverse
the order.

Grouping entries
In data tables, you can arrange entries for your convenience.

Displaying and hiding entries
Right-click any column to display a shortcut menu. The shortcut menu
lists all columns available, with check marks next to those that currently
display. Click the check boxes to display or hide any of the columns.
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Sorting entries
You can click the column header to sort the list of values in ascending (1
to 9, or a to z) or descending (9 to 1, or z to a) order.

Grouping entries
You can group entries so as to sort them by multiple criteria. For
example, you can select a primary (major) sort by Type and a
secondary (minor) sort by Description, or a primary sort by Device and
a secondary one by Event. Use the gray area above the entries to set up
groups.
If you want to create further minor sorts, you can then drag more
column headings into the gray area to create subgroups.
To group information
1. Click a column header and drag it to the grouping area labeled Drag
a Column Header Here to Group by That Column.
The column name moves to the grouping area, and the table displays
the groups you create.
2. Repeat step 1 as necessary to create more groups. Each additional
column name becomes a minor sort below the major sort that you
created in step 1. To rearrange any of these column names in the
grouping area, drag them to a new position. The table readjusts to
the new sort order.
3. Click the column header to sort the order in which the grouped
information appears.
To ungroup information
1. Click a column header in the grouping area and drag it below the
table header.
If it is the only column head in the grouping area, the table then
reverts to its original organization.
If other column headers are still in the grouping area, the table
readjusts the sort, according to the column heads that are still there.
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Saving your work
Philips recommends that you save your modified patient details
periodically as you use Telemedicine. Telemedicine automatically saves
the transmissions when they are received.
To save your work
1. On the File menu or toolbar, click Save.
Telemedicine might display a confirmation message.
2. If asked for confirmation, click Yes.
Telemedicine does not back up your database. Maintaining proper
backups is the responsibility of your IT personnel. Protect your data
by ensuring that appropriate database backup procedures are part
of your organization's practices. For more information, see Backing
up your data on page.84.

The Patients workspaces
This section describes the layout of the Patients tables and workspaces.
For instructions on using the Patients workspaces, see Using the
Patients workspaces on page.47
In the Patients navigation pane and the Patients workspace,
Telemedicine lists patient information in tables.
The tables display information in a manner similar to a spreadsheet.
Each row represents one record in the database. A record can be a
patient, a patient transmission, a 12-lead report, a trigger event and
waveform, periodic vital trends, or a system activity. Each column has
values for a specific field.
Patients table
The Patients table is on the Patients navigation pane. It lists each
incident of HeartStart MRx patient data received by Telemedicine.
These are the same patient entries that are listed in the View All
Patients workspace.
The list of patient data is based on the date and time that the patient
entry was first received by Telemedicine.
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By default, the Patients table displays the Received, Reference ID, and
Status columns.
View All Patients table
The View All Patient table is on the View All Patients workspace. It lists
each incident of HeartStart MRx patient data received by Telemedicine.
The list of patient data is based on the date and time that the patient
was first received by Telemedicine. Telemedicine also lists the current
patient status.
By default, Telemedicine lists the patients in descending order.
Transmissions pane and transmission detail panes
When you click View Latest Patient, Telemedicine opens the
Transmissions and transmission detail panes on the View Patient
workspace.
The Transmissions pane includes each transmission for the most current
patient (incident) received by Telemedicine.
The following transmission detail panes are included in the
Transmissions pane:
•

Trigger Events

•

12-Leads

•

Vital Trends

By default, Telemedicine lists the patient transmissions in descending
order.
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Using the Patients workspaces
This section explains how to use the Patients navigation pane and
workspaces to view the patient data: HeartStart MRx 12-leads, trigger
events, waveforms, and periodic vital trends.

Working with patient records
This topic describes how you can use the Patients navigation pane and
workspaces to work with patient records.

Patients navigation pane
Use the Patients navigation pane to view a list of patient records
received from the HeartStart MRx. By default, Telemedicine lists patient
records in descending order by the date and time received.
Telemedicine identifies patient records that are not yet viewed in bold
type.
Telemedicine periodically refreshes the display of patient records.
You can click Refresh on the toolbar or View menu to refresh the
display manually.

Patients workspaces
Start from the Patients navigation pane to access the Patients
workspaces.
Use the Patients workspaces to view all patient records, the latest
patient record received, or a selected patient record.
Telemedicine lists the patient records on the Patients navigation pane
and on the View All Patients workspace. The Patients navigation pane
initially displays three columns of the View All Patients workspace:
Received, Reference ID, and Status.

Patient data locations
In Telemedicine Server and Telemedicine Viewer, when you view
patient data, you are seeing the data on a Telemedicine Server.
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When you use Telemedicine Server, you always look at the same
database, configured for that Telemedicine Server.
Telemedicine Viewer is an optional software application that works with
Telemedicine Server in a system.
When you use Telemedicine Viewer, you are viewing the data that exists
on a Telemedicine Server, in a location remote from Telemedicine
Viewer.
If your workplace has multiple Telemedicine Servers, Telemedicine
Viewer can be changed to view a different Telemedicine Server, to allow
you to look at a different set of data.
For more information about Telemedicine Viewer, see Overview of
Telemedicine software on page.21, and Connecting Telemedicine Viewer
to Telemedicine Server on page.121.

Viewing all patients
Use the View All Patients workspace to view the patient records that are
received from the HeartStart MRx. By default, Telemedicine lists all the
patient records received in descending order, based on the date and
time Telemedicine received it.
You can control how the data appears in the table. See Working with
data tables on page.42.
Telemedicine displays information received from the HeartStart MRx in
the Reference ID and Institution columns. You can edit these fields and
add information in the Patient Name and Responder Impression
columns. See Adding and editing patient data on page.50.
To display the patient records
1. On the navigation pane, click the Patients navigation button.
2. On the Patients navigation pane, click View All Patients.
Click Expand
to expand a patient record to list the transmissions
received. Double-click a selected transmission to view transmission
details.
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The View All Patients workspace

1. Window title: View All Patients
2. Filter categories for viewing patient records: Day, Week, Month,
Year, and All
See To filter the number of patient records by time period on
page.50.
3. Grouping area, for grouping the data by column
See Grouping entries on page.43.
4. Patient record column headers
5. A patient record, with transmission details expanded
6. Transmission detail column headers
7.
8.

Patient vital trends transmission (Vitals)
Alarm transmission (trigger event); examples: AwRR high
alarm, EtCO2 low alarm, Start of PCDT, End of PCDT
See HeartStart MRx periodic clinical data on page.27

9.

12-lead transmission
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To display patient transmissions
Click Expand
to the left of the patient record that you want to
expand. An expanded patient record lists all the transmissions received
for the patient.
To display all patient transmissions
1. Right-click a record or row.
2. On the shortcut menu, click Expand All.
To hide a patient transmission
Click Collapse
collapse.

to the left of the patient record that you want to

To hide all patient transmissions
1. Right-click a record or row.
2. On the shortcut menu, click Collapse All.
To filter the number of patient records by time period
1. On the Patients navigation pane, click View All Patients to
display the View All Patients workspace.
2. On the Patients pane or on the View All Patients workspace, click
a filter button at the top of the workspace: Day, Week, Month,
Year, or All.

Adding and editing patient data
On the View All Patients workspace, you can add and edit information
about a patient in the Institution, Patient Name, Reference ID, and
Responder Impression columns.
The changes appear on the View All Patients pane. However, on the
View Patient pane and destinations, Telemedicine displays and
prints the transmission with the patient information received from
the HeartStart MRx.
Telemedicine stores the most recent changes saved in the Institution,
Patient Name, Reference ID, and Responder Impression columns.
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To avoid overwriting the information by mistake, Philips
recommends that you designate one person to change the field
data.

To add or edit patient data
1. Click the Institution, Patient Name, or Reference ID field, and
then type text.
2. Click the Responder Impression field, click the down arrow, and
click Other from the menu; then type text in the field, Alternatively,
you can click one of the provided entries: Cardiac Arrest, Chest
Pain, Poison/Overdose, Pediatrics, Respiratory, Stroke, or
Trauma. You can also type additional text in these provided fields.
3. On the File menu or toolbar, click Save.
The message Save changes before continuing? appears.
•

Click Yes to save the edits.

•

Click No to remove the edits and continue.

•

Click Cancel to restore the original text and keep the cursor at the
current location.
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Viewing patient transmission details
Use the View Patient workspace to view transmissions and selected
transmission details.
The workspace can consist of four areas: Transmissions, Waveform, 12Lead, and Vital Trends.
By default, transmissions on the Transmissions pane appear in
descending order based on the date and time that Telemedicine received
it. You can filter the type of transmissions that appear in the list. You
can also click a transmission to display the details to the right of the
Transmissions pane.
Telemedicine displays transmissions with the patient information
received from the HeartStart MRx.
The View Patient workspace
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Features in the View Patient workspace
1. Window title: View Patient
2. List of transmissions for this patient
3. Expand to view transmission details
4. Waveform transmission details, for trigger events
5. 12-lead transmission details
6. Vital trends transmission details
To display the View Patient workspace
1. On the navigation pane, click Patients.
2. To display the Transmission pane, use one of the following
methods:
•

On the Patients navigation pane, double-click a patient record.

•

On the Patients navigation pane, click View All Patients to
display the list of patient records, and then double-click a patient
record.

•

On the Patients navigation pane, click a patient record, and
then click View Latest Patient.

The following information for the patient record appears above the
Transmission pane: patient ID, date and time, and device.
3. On the Transmissions pane, click a transmission.
The patient transmissions appear on the Transmissions pane and
on the appropriate pane or tab: Waveform, 12-Lead, or Vital
Trends.
4. You can view the transmission details.
•

Click Expand
to the left of the transmission that you want to
expand. An expanded transmission lists the available details.

•

Click Collapse
to collapse.

to the left of the transmission that you want

For more information about grouping and sorting the data, see Working
with data tables on page.42.
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Using Report Preview
The Report Preview window is available from the Print Report button, on
the Telemedicine toolbar, and also from the File menu.
Print Report is available when the Patients workspace is active.

To open the Report Preview window
1. In the Patient workspaces, click the data you want to preview.
2. To preview a patient report, from the Telemedicine toolbar, or from
the File menu, click Print Report. A preview of the patient report
opens, with a viewing and printing toolbar.
You can also preview the patient report using the following method:
To preview a report of selected data, click the arrow to the right of
Print Report. A menu opens with the following selections:
•

Patient Report

•

Selected 12-lead

•

Selected Waveform

•

Vital Trends

Click the selection to preview your selected report.
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Report Preview window

1. Window title: Report Preview
2. Toolbar
3. Print tools
4. Navigation tools
5. Zoom tools
6. Export
7. Customization tabs: Report Customization, 12-Lead Customization,
and Trending Customization (this tab is shown forward)
8. Report title
9. Current page of report, total number of pages, and zoom percentage
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Reports toolbar buttons
Button

Description
Click Print or press CTRL+P to select a printer, number of
copies, or other printing options before printing.
Click Quick Print to send the document directly to the
default printer without making changes.
Click Find to find text in the document, based on your
entry in the Find What field and Search options.
Click First Page or press CTRL+HOME to navigate to the
first page of the document.
Click Previous Page to navigate to the previous page of
the document.
Click NextPage or press PAGEDOWN to navigate to the
next page of the document.
Click Last Page or press CTRL+E ND to navigate to the
last page of the document.
Click the Arrow to select the pointer (to deselect the
zoom tools).
Click the Hand tool to manually move up, down, left, or
right on the report pages.
Click Zoom Out to see more of the page at a reduced
size.
Click Zoom In to get a close-up view of the document.

Click Export to PDF to export the report as a PDF and
save it.

Working with patient reports
You can generate a patient report for the selected patient in the View All
Patients or View Patient workspaces.
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When working from the View Patient workspace, in order to include
trigger events and waveforms in the Patient Report, click a trigger
event with a waveform, so the waveform is displayed in the View
Patient workspace, before clicking Print Report.

To preview the patient report
•

From Print Report, click the down arrow and click Patient
Report.
The Report Preview window opens.

To customize settings for a patient report in Report Preview
1. On the Report Customization tab, click the data types you want to
include: 12 Lead, Waveforms, and Vitals Trending are available.
These options are selected by default. To exclude a data type, clear
the checkbox.
2. On the 12-Lead Customization tab, you can select options for how
the 12-leads are shown. For more information, see Working with 12lead reports on page.57.
3. On the Trending Customization tab, you can select options for
how vital trends are shown. For more information, see Working with
vital trends reports on page.58.
For an overview of the Report Preview window, see Using Report
Preview on page.54. For printer setup instructions, see Setting up for
printing 12-lead reports on page.111. For printing instructions, see
Printing reports on page.61.

Working with 12-lead reports
You can generate a 12-lead report for the selected patient in the View All
Patients or View Patient workspaces.
12-lead reports may contain personal patient-identifiable data. Be
sure to handle this data in accordance with the patient privacy
requirements of your organization, and with applicable local laws
such as HIPPA.

To preview the 12-lead report
•

From Print Report on the menu, click the down arrow and click
Selected 12-Lead.
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The Report Preview opens.
To customize settings for a 12-Lead report
1. Select a timing option. In the Timing field, click Simultaneous or
Time Sequential.
•

Simultaneous 12-lead ECG report marks each segment with
double vertical lines. It is the preferred 12-lead report format
used in the Europe.

•

Time-sequential 12-lead ECG report marks each segment with a
single vertical line. It is the preferred 12-lead report format used
in the United States.

2. The 12-lead report can appear with or without a grid in the
background of the ECG. Click Display grid to add a grid to the
background of the 12-lead report. Clear Display grid to remove the
grid.
For printer setup instructions, see Setting up for printing 12-lead reports
on page.111. For printing instructions, see Printing reports on page.61.

Working with vital trends reports
You can generate a Vital Trends report for the selected patient in the
View All Patients or View Patient workspaces.
This report is created from the vital trends information that appears on
the Vital Trends pane or tab on the View Patient workspace. The vital
trends information appears in a table format.
To preview the Vital Trends report
•

From Print Report on the menu, click the down arrow and click
Vital Trends.
The Report Preview opens.

On the Trending Customization tab, you can customize settings in the
Vital Trends report.
To customize the vital trends report
1. Set the vital trends time interval. In the Interval field, click 1, 5,
10, 15, 30, or 60 minutes interval duration.
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2. Change the display order. Click Show latest first to display the
most recent vital trends interval first. Clear the selection to display
the oldest vital trends interval first.
For an overview of the Report Preview window, see Using Report
Preview on page.54. For printing instructions, see Printing reports on
page.61.

Working with waveform reports
You can view Trigger Events and waveform data for the selected patient
in the View All Patients or View Patient workspaces.
Not all trigger events include waveforms. For more information,
see HeartStart MRx periodic clinical data on page.27.
The waveform for a trigger event appears in the Waveform pane or tab
on the View Patient workspace.
To preview the waveform report
1. On the View Patient workspace, click the patient data with trigger
events that include waveforms.
2. From Print Report, click the down arrow and click Selected
Waveform.
The Report Preview opens.
For an overview of the Report Preview window, see Using Report
Preview on page.54. For printing instructions, see Printing reports on
page.61.
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Emailing patient data
You can email a PDF of a full patient report, or of a selected part of the
report.

Emailing a PDF of selected patient data transmissions
When you send a 12-lead report to a configured email address
manually, Telemedicine starts your default email application. For
example, Telemedicine might start Microsoft Outlook, or Outlook
Express.
To manually email a selected patient transmission
1. Click a patient record from the View All Patients workspace, or a
selected patient transmission from the View Patient workspace.
2. On the File menu, click Email PDF and click an option: Patient
Report, Selected 12-Lead, Selected Waveform, or Vital
Trends.
If the patient data you selected does not have some of the data
types, those options will be unavailable.
3. Complete one of the following methods:
If Telemedicine is set up to password-protect email:
The File Security window appears.
•

Click the Protect File with Password check box and type a
password. Then, click OK to password-protect the attachment.
The password can be the same password that you assigned to an
email address on the Email Destinations workspace.
If you protect the file with a password, be sure to use a
separate communication or email to tell the data recipient the
password that you assigned to the file.

If Telemedicine is not set up to password-protect email:
•

Click OK to email the attachment without a password.
Telemedicine starts your default email application and attaches
the PDF.

4. Address and send the email.
For information about email in Telemedicine, see Email requirements on
page.109, and Editing or deleting email addresses on page.109.
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Printing reports
Locate tools for printing reports from Print Report on the File menu, or
from the Print Report button on the toolbar. Both locations include a
submenu with print options: Patient Report, Selected 12-Lead, Selected
Waveform, or Vital Trends.
Print Report is available only when the Patients workspace is active.
Some setup steps are required before printing a 12-lead report. See
Setting up for printing 12-lead reports on page.111.
When you click a print option, the Report Preview window opens. For
more information, see Using Report Preview on page.54.
You can customize the appearance of reports before printing. See
Working with 12-lead reports on page.57, and Working with vital trends
reports on page.58.
To print a report
To print the report, use one of the following Report Preview
toolbar buttons:
1. Click Quick Print
to send the report directly to the default
printer without making changes.
Your print is made without additional steps.
or
1. Click Print
to select a printer, number of copies, and other
printing options.
The Windows Print window opens.
2. Make your selections in the Windows Print window, and then click
Print.
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Faxing 12-lead reports
You can fax a 12-lead report automatically or manually.
The 12-lead report that Telemedicine faxes might not be of
diagnostic quality.
Each Telemedicine Viewer computer must have a fax service. Send
Fax Wizard is part of Microsoft Fax Service. If you have not
installed Microsoft Fax Console, use the Windows Help and Support
feature. Type Fax in the Search field and follow Microsoft’s
instructions.

Faxing 12-lead reports automatically
Telemedicine automatically faxes 12-lead reports to the fax numbers
that you add to the default Auto Send List. For more information, see
Using Auto Send Lists on page.65.

Faxing 12-lead reports manually
There are two ways to fax 12-lead reports manually: from a configured
fax destination, or from the fax selection within the Print window.
Configured fax destination numbers are available from the Forward
Selected 12-Lead option on the File menu. For more information, see
Forwarding patient data on page.63.
To fax a 12-lead report to a configured fax destination
•

On the File menu, click the Forward Selected 12-Lead option to
manually fax a 12-lead report to an alternate fax destination.
The Microsoft Send Fax Wizard window appears. Follow the onscreen instructions.

To fax a 12-lead report to an alternate fax destination
1. Select a 12-lead report from one of the following areas:
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Display the View All Patients workspace. Click a patient record
and click Expand
to the left of the row to open the list of
patient transmissions, including 12-leads. For more information,
see Viewing all patients on page.48.

•

Display the View Patient workspace. Click a 12-lead from the
Transmissions pane. For more information, see Viewing
patient transmission details on page.52.

2. When you have a 12-lead report selected, on the File menu, click
Fax 12-Lead.
The Print window appears.
3. In the Print window, in the Select Printer area, click Fax and then
click Print.
The Microsoft Send Fax Wizard window appears. Follow the onscreen instructions.

Forwarding patient data
Use the Forward options on the File menu to send selected patient data
manually.
The destinations that are available on the menus depend on the
destinations configured in Telemedicine.
Telemedicine can forward the 12-lead reports to TraceMasterVue and to
DatamedFT. DatamedFT converts HeartStart MRx 12-lead reports to
another format, for example, to GE MUSE format. A location for
DatamedFT is a directory that is monitored by the DatamedFT software.
For more information, see Setting up software applications as
destinations on page.103.
To forward patient data from the View All Patients workspace
1. Display the View All Patients workspace. For more information,
see Viewing all patients on page.48.
2. Click a patient row in the table.
3. Click Expand

to the left of the row.

4. Click a transmission.
5. On the File menu, click an option for forwarding.
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If you click Forward Selected 12-lead, Telemedicine displays a
menu of destinations.
•

Auto Send List

•

Application

•

Fax

•

Printer

•

Email

Click a destination type.
or
If you click Forward Patient, Forward Selected Waveform , or
Forward Vital Trends, Telemedicine displays a list of Web Server
destinations. Click a destination.
Telemedicine completes the connection, sends the selected
transmission, and displays a confirmation message.
You can also forward patient data from the View Patient workspace. To
do so, first select the data from the Transmissions pane. For more
information, see Viewing patient transmission details on page.52.
Follow the instructions for forwarding in the previous procedure.
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Using Auto Send Lists
With an Auto Send List, you can send patient data to a configured
destination, or to a number of destinations, with one step.
Philips recommends that your Auto Send Lists be set up by
experienced IT personnel.
You can configure an Auto Send List to send a 12-lead report to one or
more of the following types of destinations:
•

HeartStart 12-Lead Transfer Station 3.0

•

TraceMasterVue

•

DatamedFT

•

Another Telemedicine System

•

Fax machine

•

Printer

•

Email address

Each named destination on a HeartStart MRx can be a single destination
on Telemedicine, or the name of an Auto Send List.
If the name of the HeartStart MRx destination is the same as the name
of the Auto Send List, then Telemedicine sends the 12-lead report to
each destination in that Auto Send List.
Auto Send List capabilities
You can save up to 50 Auto Send Lists. Each Auto Send List can
contain up to 20 destinations.
Auto Send Lists can be configured in many ways, depending on user
needs. An Auto Send List can consist of only one destination, or of many
destinations. A destination can appear on more than one Auto Send List.
The default Auto Send List
During the Auto Send List configuration process, you can set one list to
be the default Auto Send List.
If the site name for the HeartStart MRx hub does not match the name of
a configured Auto Send List, Telemedicine sends the 12-lead report to
the default Auto Send List.
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If no default Auto Send List is configured, and the HeartStart MRx hub
does not match the configured Auto Send List, Telemedicine adds the
12-lead report to the database. You can then use Forward Selected 12Lead to send the 12-lead report manually. For more information, see
Forwarding patient data on page.63.
To see which Auto Send List is set as the default
1. In the Administration workspace, click Auto Send Lists
workspace.
The Auto Send Lists workspace opens.
2. In the Details area, look at the Set as the Default Auto Send
List checkbox.
When this checkbox is checked, the displayed Auto Send List is the
default Auto Send List.
3. To change the Auto Send List that is displayed, click a different Auto
Send List from the Summary area of the Auto Send Lists
workspace.
The selected Auto Send List iappears in the Details area.
For information about configuring Auto Send Lists, intended for
experienced IT personnel, see Setting Up Auto Send Lists on page.112.

Importing HeartStart MRx 12-lead
reports from a data card
If you receive HeartStart MRx 12-lead reports on a data card, you can
use Telemedicine to import the data.
If Telemedicine is configured with a default Auto Send List,
Telemedicine automatically sends the imported 12-lead reports to
all the destinations in the default Auto Send List.
If you do not want to send an imported 12-lead report to a
destination, clear the check box for the destination in Destinations.
For more information, see Editing or deleting Auto Send Lists on
page.115.
Use the Import option to import a 12-lead report manually from other
sources, such as additional data cards, memory sticks, or another
location.

66

3 - Everyday use of Telemedicine

HeartStart Telemedicine System User Guide

To import and display a 12-lead report
1. Insert the data card into the appropriate reader.
2. Click the Patients navigation button.
3. On the File menu or toolbar, click Import.
The Windows Open window appears.
4. Navigate to the location of the 12-lead report.
5. Click the 12-lead report name.
6. Click Open.
The 12-lead report appears on the Patients pane.
7. On the Patients pane, double-click the 12-lead report.
The 12-lead report appears in the 12-Lead pane.

Deleting patient data
Telemedicine does not back up your database. Maintaining proper
backups is the database administrator's responsibility. Ensure that
your database administrator sets up appropriate database
management tools and checks that they execute successfully. See
Backing up your data on page.84.
You can delete a selected patient record on the Patients navigation pane
and on the View All Patients workspace manually. Patient data can
include all the 12-lead report, trigger event and waveform, and periodic
vital trend transmissions associated with the patient record.
By default, Telemedicine keeps 12-lead report entries for 30 days. You
can change this setting on the General Configuration workspace,
available from the Administration navigation pane. After the set number
of days expire, Telemedicine displays a prompt when you start the
software. Telemedicine does not automatically delete the entries from
the database.
To delete a patient record
1. On the navigation pane, click the Patients navigation button.
2. Use one of the following methods to select a patient record:
•

On the Patients navigation pane, click a patient record.
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On the Patients navigation pane, click View All Patients to
display the list of all patient records, and then click a patient
record.

3. On the File menu or toolbar, click Delete.
4. Click Yes to delete the patient record, or click No to cancel the
process.
When you delete the selected data, Telemedicine deletes all the data
associated with the selected patient record.
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Working with the system log
The system log lists Telemedicine activity.
For each action, Telemedicine identifies the following information:
•

The type of activity, for example, Information or Error

•

The action that occurred

•

A description of the action

•

The date and time when the action occurred

Users can view the system log to check whether a transmission
occurred.
The system log can provide a customer support technician with
information about your Telemedicine system.
Messages that appear while you are using Telemedicine are briefly
explained in the section System log messages on page.132.
The system log should be maintained by experienced IT personnel. For
more information, see Clearing system log entries on page.131.

Opening the system log
The system log is available from the Administration navigation pane.
You can control the way system log messages are displayed. For more
information, see Working with data tables on page.42.
To display the system log
1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click System Log.
The system log opens.
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Administration of
Telemedicine
This section is intended for IT personnel.
Philips strongly recommends that the installation, configuration,
and maintenance of your Telemedicine system, and the
administration of the Telemedicine database, be done by
experienced IT personnel.
For more information, see Recommended IT skills on page.16.
For information about implementing data transfer between the
HeartStart MRx and Telemedicine, see the Data transmission
implementation guide, publication number 453564058751.

70

4 - Administration of Telemedicine

HeartStart Telemedicine System User Guide

About the Telemedicine installation
There are two types of Telemedicine installations: Telemedicine Server
and Telemedicine Viewer. You must install Telemedicine Server if you
want to use Telemedicine Viewer. Telemedicine Viewer is optional.
You can install Telemedicine as a new installation. You can install and
run the new version for 60 days while you purchase a license.
Telemedicine stops working if you do not activate the software within 60
days of installation.
You can install Telemedicine as an update to a previous version of
Telemedicine, or as an update to HeartStart 12-Lead Transfer station.
The Telemedicine installation process migrates the previous version and
keeps the database.
For more information about updating, see Upgrading Server software
and migrating data on page.77.

Before you install Telemedicine software
The Telemedicine Server software is available in two editions. The same
download becomes either Telemedicine Classic 12-Lead Edition or
Telemedicine Critical Care Edition, depending on the license key
entered.
Until you activate your license key, the Telemedicine Server
software opens as Telemedicine Critical Care Edition.
The optional Telemedicine Viewer software is available as a separate
download. Telemedicine Viewer works with either edition of
Telemedicine Server.
For more information, see Overview of Telemedicine software on
page.21.
When you download Telemedicine software, save it on your computer.
You can also save the downloaded software on a CD, DVD, or other
media.

Confirm the following:
•

A static IP address is assigned to the Telemedicine Server and
connected to the Internet.

•

The Internet connection is able to be on all the time.
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•

The Internet Service Provider (ISP) allows inbound communication
on TCP port 80.

•

Web services are set up.
Confirm that IIS is installed and running on the computer for
Telemedicine Server before you install the Telemedicine Server
software. For information about setting up Web Services, see
Setting up the Telemedicine Web Service on page.96.

If you use HeartStart 12-Lead Transfer Station
You cannot run Telemedicine Server and HeartStart 12-Lead Transfer
Station on the same computer.
For information about migrating your database from HeartStart 12-Lead
Transfer Station to Telemedicine Server, see Upgrading Server software
and migrating data on page.77.
If you used TraceMaster as a destination in a previous version of
HeartStart 12-Lead Transfer Station, check with your sales
representative to upgrade to TraceMasterVue.

Installing Telemedicine
You need Windows administrator privileges to install Telemedicine
software.
Confirm that IIS is installed and running on the computer for
Telemedicine Server before you install the Telemedicine Server
software. For information about setting up Web Services, see
Setting up the Telemedicine Web Service on page.96.
Use the following procedure to install either Telemedicine Server or
Telemedicine Viewer software.
To install the Telemedicine software
1. Navigate to the directory where you saved the downloaded
Telemedicine installation file with the .exe extension.
2. Double-click the installation file.
3. Follow the on-screen instructions.
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Activating Telemedicine
After you install the software, activate the product. Activation is a
Philips antipiracy technology designed to verify that software products
are licensed legitimately.The activation process migrates the data for
the previous version to the current installation. Depending on your data,
the migration might take a few minutes.
You can use the Internet or email to activate the software within 60 days
after you install the application. Until you complete the activation, you
will see the Philips HeartStart Activation Wizard window when the
application starts.
Save the serial number in a safe place that you can access in case
you need to re-install the software.
Select one of these methods to activate your software:
•

Activate over the Internet

•

Activate by Email

•

Activate Later

Activate over the Internet
You can activate the software by the Internet when you first install the
application, or within 60 days of installation.
The activation wizard sends encrypted information to the Philips server
to validate that the serial number you enter has not already been used
for the allowed number of installations and to activate your software. If
you are not connected to the Internet, the wizard alerts you that there is
no connection.
To activate the software by the Internet
1. Start the application. For information about starting the application,
see Starting Telemedicine on page.39.
The application opens the Activation Wizard.
2. Type the serial number that you received. Do not type the activation
code.
3. Click I want to activate the software over the Internet.
4. Click Activate.
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The wizard starts the application.

Activate by Email
Email activation support is available in English only at:
activation.support@philips.com.
You can request software activation by email after you first install the
application, or within 60 days of installation.
The email activation involves exchanging emails with Philips Customer
Support. The activation wizard attaches an encrypted file when it sends
the activation request. Customer Support sends the activation code.
An email application must be installed on this computer, or you must
have access to an installed email application. You can continue to use
the software for up to 60 days before you complete the activation.
If an email application is not installed on this computer, you can contact
your Philips sales representative or local sales office. See Customer
support on page.141.
The Activation Wizard online Help includes the steps on how to
activate the software by email.

To activate the software by email
1. Start the application.
The application opens HeartStart Activation Wizard.
2. Type the serial number that you received.
3. Click I want to activate the software by email.
4. Click Next.
5. Click Request Activation Code to open your email application with
a pre-addressed email activation request.
6. Click Send.
Customer Support will send you an email with the activation code.
When you receive an email from Customer Support, complete the
following:
1. Start the application.
The application opens the HeartStart Activation Wizard.
2. Verify or type the serial number that you received.
3. Click I want to activate the software by email.
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4. Click Next to access the Activate by Email page.
5. In the Enter your activation code here field, type the activation
code.
6. Click Activate.
The wizard validates your entry and displays a congratulations
message.
7. Click OK.
The wizard starts the application.

Activate Later
If you do not want to activate your copy of Telemedicine when you first
start it, you can wait up to 60 days to activate the software.
Free trial period
You can use Telemedicine without activating it during the free trial
period, which lasts for 60 days from the day you first install the
software. During the 60 days, you can use the software and save your
work. Until you activate the software, you will see the HeartStart
Activation Wizard window each time that you start the application. After
the 60 days ends, if you still have not activated Telemedicine, you can
no longer use the software, and you cannot download the application for
trial again on the same computer. You can purchase the license and
activate the installed software to continue using it.
Until you activate your license key, the Telemedicine Server
software opens as Telemedicine Critical Care Edition.

To use the application without activating the software
1. Start the application.
2. When HeartStart Activation Wizard opens, click Skip.
The wizard starts the application.

Registering Telemedicine
You can register your copy of the Telemedicine application to help
Philips to provide you with information and software updates.
Registration is optional and not the same as the activation, which is
required. You can register by the Internet.
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To register the software
1. In Windows, start your Internet browser.
2. Navigate to the following URL:
http://www.medical.philips.com/main/products/resuscitation/software_
registration/index.wpd
3. Click a language.
4. On the language page, click the product.
5. Complete the registration form.

Uninstalling Telemedicine
The process is the same, whether you are uninstalling Telemedicine
Server on the server computer or uninstalling Telemedicine Viewer on
the viewer computer.
The uninstall process contacts the Philips activation server and
releases your serial number for installation on another computer.
The uninstall process will not remove the application database from
the server computer.
You need Windows administrator privileges to uninstall Telemedicine
software.
To uninstall Telemedicine
1. Stop the Bluetooth Monitor using the following steps:
a. On the System tray, right-click the Bluetooth Monitor icon
b. Click Exit Telemedicine Bluetooth Monitor.

.

Telemedicine stops the Bluetooth Monitor and removes the icon from
the system tray.
2. Remove Telemedicine using the following steps:
a. From the Start menu, click Control Panel.
b. Navigate to Uninstall or change a program.
c. Click Philips HeartStart Telemedicine and click Uninstall.
The program is removed from the computer.
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Restoring the system configuration for
Telemedicine
Telemedicine stores the system configuration and destinations in the
database.
You can restore your system configuration by restoring the database
from backups.
If you restore the database from the backup, then all patient data
reverts to the state it was in when the backup was made, and any
changes since that time are lost.

To restore system configuration for Telemedicine
1. Set up Telemedicine. For more information, see The Telemedicine
Monitoring Service on page.96.
2. Use your backup-and-restore tool to restore the Telemedicine
database and configuration.
3. Start Telemedicine and test the configuration and destinations.

Upgrading Server software and migrating data
If you use a previous version of Telemedicine Server, or 12-Lead
Transfer Station, follow these instructions to upgrade to the current
version of Telemedicine Server software.
If you are planning to migrate data from an older system to the new
system, Philips recommends that you do this before you configure
the new system. This is because configuration changes saved on the
4.2 system before a data migration will be overwritten by
configuration settings from the older system during the data
migration.
If you use the TraceMasterVue or DatamedFT destinations, check
with your sales representative to ensure that your version of these
applications are compatible with Telemedicine and the HeartStart
MRx.
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Upgrading from Telemedicine 4.1 to Telemedicine 4.2
You can upgrade without cost from Telemedicine Server 4.1 to
Telemedicine Server 4.2 by reusing the product serial number, also
called the activation key.
If you are using the same computer, simply install the Telemedicine
Server 4.2 software to convert your system to Telemedicine Server 4.2.
No other changes are required.
If you currently have Telemedicine Server 4.1 and you want to install
Telemedicine Server 4.2 on a new computer, follow the instructions in
Upgrading from a previous version of Telemedicine to Telemedicine 4.2
on a different computer on page.78, and Migrating data to Telemedicine
4.2 on page.81.

Upgrading from Telemedicine 4.0 to Telemedicine 4.2
You can upgrade without cost from Telemedicine Server 4.0 to
Telemedicine Server 4.2 by reusing the product serial number, also
called the activation key.
You cannot install Telemedicine Server 4.2 on the same computer
as Telemedicine Server 4.0. This is because Telemedicine Server
4.2 requires the Windows 7 or the Server 2008 R2 operating
system, and Telemedicine Server 4.0 operates on the Windows XP
and Windows Server 2003 operating systems.
To reuse your Telemedicine Server 4.0 product serial number for
Telemedicine Server 4.2 on a new computer, see Upgrading from a
previous version of Telemedicine to Telemedicine 4.2 on a different
computer on page.78.

Upgrading from a previous version of Telemedicine to Telemedicine
4.2 on a different computer
You will temporarily use the previous version of Telemedicine Server
software on the older computer while setting up Telemedicine Server
4.2 on the new computer.
After you install the Telemedicine Server 4.2 software, you can choose
to migrate your existing data and configuration to Telemedicine Server
4.2. Alternatively, if you choose, you can start over, with only new data.
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As part of your upgrade process, test your destinations, such as fax and
printers, by sending information to the destinations. Software that is
installed properly on the new server will work the same as the previous
version of Telemedicine software. For information about the
configuration process, see Configuring the Telemedicine Server on
page.86.
To make your previous Telemedicine Server product serial number
available for your upgrade, you must uninstall the previous version of
Telemedicine Server software, so you can release the license and reuse the product serial number to activate the Telemedicine Server 4.2
software.
To reuse your product serial number
1. From your computer with a previous version of Telemedicine, use
the Check for Updates option on the Help menu to download the
Telemedicine 4.2 software and save it to a removable data storage
medium.
2. Install Telemedicine Server 4.2 on the computer that is running
Windows Server 2008 R2, or Windows 7.
3. (Optional) If you choose to import (migrate) your existing patient
data and Telemedicine Server configuration, do that now. See
Migrating data to Telemedicine 4.2 on page.81.
4. Validate and very your network connections. You can send an ECG
from the HeartStart MRx to test destinations, such as a fax number
or email address.
5. Make sure that your computer with a previous version of
Telemedicine Server is connected to the Internet when you perform
the next step, to release the product serial number for reuse.
6. Uninstall the previous version of Telemedicine. For more
information, see Uninstalling Telemedicine on page.76.
The product serial number is released for reuse on your new
installation.
7. Activate the Telemedicine Server 4.2 software using the product
serial number. See Activating Telemedicine on page.73.
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You can find the product serial number on the Proof of Purchase
Certificate for the previous version of Telemedicine. The serial
number is the 18-character alphanumeric code that is below the
barcode. If you cannot locate the Proof of Purchase Certificate,
locate your sales order number or your purchase order number,
and call the nearest response center for customer support.

Upgrading from 12-Lead Transfer Station 3.0 to Telemedicine 4.2
You cannot install Telemedicine Server 4.2 on the same computer
as 12-Lead Transfer Station 3.0. This is because Telemedicine
Server 4.2 requires the Windows 7 or the Server 2008 R2 operating
system, and 12-Lead Transfer Station 3.0 operates on older
operating systems.
If you are upgrading from 12-Lead Transfer Station 3.0, you must
purchase an upgrade.
•

Purchase #861441-A01 to upgrade from 12-Lead Transfer Station
3.0 to Telemedicine 12-lead Classic edition.

•

Purchase #861441-A03 to upgrade from 12-Lead Transfer Station
3.0 to Telemedicine Critical Care edition.

This upgrade will give you a serial number to apply to your new
software. You do not need to uninstall 12-lead Transfer Station software
to begin using the Telemedicine system. You can use both of the serial
numbers.
For more information about activating Telemedicine, and about the trial
period, see Activating Telemedicine on page.73.
If you are interested in migrating your database from 12-lead Transfer
Station to the Telemedicine, be sure to read the following section on
database migration.
If your 12-Lead Transfer Station 3.0 sends data to TraceMaster, note
that Telemedicine does not support TraceMaster as a destination, so it
does not migrate TraceMaster destination data. Those destinations will
not be included when your configuration data is migrated.
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Migrating data to Telemedicine 4.2
At any time after you install the Telemedicine Server 4.2 software, you
can migrate data to Telemedicine Server 4.2. You can migrate data from
the 12-Lead Transfer Station 3.0, Telemedicine 4.0, or Telemedicine
4.1. (Migrating data from Telemedicine 4.1 is necessary only if
Telemedicine 4.2 is installed on a different computer than Telemedicine
4.1. For more information, see Upgrading from Telemedicine 4.1 to
Telemedicine 4.2 on page.78.)
The 12-Lead Transfer Station 3.0, or the previous version of
Telemedicine, must be on the same intranet as Telemedicine
Server 4.2.
During the migration, configuration data and patient data are migrated
to Telemedicine Server 4.2. System log data is not migrated.
Before you perform the data migration, you need to open the firewalls
on both computers to allow connection by the Telemedicine Server 4.2
computer to the computer with the database that is being migrated.
For guidelines on opening the firewalls, see the procedures in
Configure access to the Telemedicine Server database on page.117.
For this purpose, treat your Telemedicine Server 4.2 computer as a
Telemedicine Viewer computer.
Complete the following steps for each database migration that you want
to complete.
To ensure a complete migration of data, close the software
application (12-Lead Transfer Station 3.0 or Telemedicine) on the
older server while data is being migrated to the newer server.

To migrate your data to Telemedicine Server 4.2
1. Start Telemedicine Server 4.2.
2. Click the Administration navigation button.
3. On the File menu, click Migrate Database.
The HeartStart Database Migration window opens. Click the down
arrow to view a list of servers. The server shown at the top of the
list is your current server.
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4. From the list of servers, click the server with the data to be
migrated. You can also type the IP address of the server, followed
by /HEARTSTART.
5. Click Test.
The data migration is tested, and a status message appears. When
the migration test is successful, the Migration button becomes
available.
6. Click Migration.
Data migrates to the new server, and a new status message
appears.
7. When the status message confirms that data migration is successful,
click Exit.
A warning message appears, prompting you to restart the
Telemedicine application after database migration.
8. Restart Telemedicine Server.
9. Review the following to verify the results of the data migration:
a. Verify that the configuration settings of the previous version of
Telemedicine Server were migrated to Telemedicine Server 4.2
by reviewing the Administration workspaces. For more
information, see Setting up the General Configuration area on
page.86.
b. Verify that all patient data is migrated to Telemedicine Server
4.2 by reviewing the data on the All Patients and Patients
workspaces. For more information, see Working with patient
records on page.47.
c. On the Administration workspace, click System Log to check
the system log for the status of the database migration process.
10. Test all of the previously configured transmission operations.

Upgrading Viewer software
If you have an earlier version of Telemedicine Viewer software, upgrade
to Telemedicine Viewer 4.2 in order to use it with Telemedicine Server
4.2.

Upgrading from Telemedicine Viewer 4.1 to Telemedicine Viewer 4.2
You can upgrade without cost from Telemedicine Viewer 4.1 to
Telemedicine Viewer 4.2 by reusing the product serial number, also
called the activation key.
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If you are using the same computer, simply install the Telemedicine
Viewer 4.2 software to convert to Telemedicine Viewer 4.2. No other
changes are required.
If you currently have Telemedicine Viewer 4.1 and you want to install
Telemedicine Viewer 4.2 on a new computer, follow the instructions in
Upgrading from a previous version of Telemedicine Viewer to
Telemedicine Viewer 4.2 on a different computer on page.83.

Upgrading from Telemedicine Viewer 4.0 to Telemedicine Viewer 4.2
You can upgrade without cost from Telemedicine Viewer 4.0 to
Telemedicine Viewer 4.2 by reusing the product serial number, also
called the activation key.
You cannot install Telemedicine Viewer 4.2 on the same computer
as Telemedicine Viewer 4.0. This is because Telemedicine Viewer
4.2 requires the Windows 7 operating system, and Telemedicine
Viewer 4.0 operates on the Windows XP operating system.
You can reuse your Telemedicine Viewer 4.0 product serial number for
Telemedicine Viewer 4.2 on a new computer. See To reuse your product
serial number on page.83.

Upgrading from a previous version of Telemedicine Viewer to
Telemedicine Viewer 4.2 on a different computer
You will temporarily use the previous version of Telemedicine Viewer
software on the older computer while setting up the new Telemedicine
Viewer on the new computer.
To make your previous product serial number available for your
upgrade, you must uninstall the previous version of Telemedicine
Viewer software.This releases the license so that you can re-use the
product serial number to activate the new Telemedicine Viewer
software.
To reuse your product serial number
From your computer with the previous version of Telemedicine Viewer,
use the Check for Updates option on the Help menu to download the new
Telemedicine Viewer software and save it to a removable data storage
medium.
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1. Install the new Telemedicine Viewer on the computer that is running
Windows 7.
2. Make sure that your computer with a previous version of
Telemedicine Viewer is connected to the Internet when you perform
the next step, to release the product serial number for reuse.
3. Uninstall the previous version of Telemedicine Viewer. For more
information, see Uninstalling Telemedicine on page.76.
The product serial number is released for reuse on your new
installation.
4. Activate the new Telemedicine Viewer software using the product
serial number. See Activating Telemedicine on page.73.
You can find the product serial number on the Proof of Purchase
Certificate for the previous version of Telemedicine. The serial
number is the 18-character alphanumeric code that is below the
barcode. If you cannot locate the Proof of Purchase Certificate,
locate your sales order number or your purchase order number,
and call the nearest response center for customer support.
5. Set up the new Telemedicine Viewer to communicate with the new
Telemedicine Server, following the instructions in Configuring the
Telemedicine Viewer on page.117.

Backing up your data
The Telemedicine database is low-maintenance compared to many other
databases. Nonetheless, attention to routine maintenance tasks will help
to ensure database integrity.
Telemedicine does not back up your database. Maintaining proper
backups is the responsibility of your IT personnel.
Protect your data by ensuring that appropriate database backup
procedures are part of your organization's practices. Set up appropriate
database management tools and check that they execute successfully.
The Telemedicine database server name is \<machine
name>\HeartStart.
The database name is PDTS40.
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Back up the Telemedicine database on a regular basis (preferably every
day) to tape or some other medium. Disaster-recovery experts
recommend that you store the backup tapes somewhere safe, so that
disasters such as fire or theft cannot harm them. Without a recent
backup, you have no chance of recovery after a catastrophe (disk
failure, fire, mistakenly erasing a critical table, etc.).
Philips recommends that you store backup information at a separate
location. You should have a plan for recovering information in the case
of a software or hardware failure.
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Configuring the Telemedicine Server
The computer running Telemedicine Server must be configured as part
of Telemedicine setup. You need to perform several tasks, both before
and after installing the Telemedicine software, to configure the
Telemedicine Server.
Configuration includes the following four essential parts
•

The Telemedicine Server application—Displays HeartStart MRx
patient data (12-lead reports, trigger events [alerts] and
waveforms, and vital trends), and stores the 12-lead reports, and
periodic clinical data transmissions (alerts, vitals, waveforms), and
configuration information, and system log information.

•

Web Service—IIS transfers the data received from the HeartStart
MRx, or from another instance of Telemedicine, to the Web service.
The Web service saves the data in the appropriate inbox.

•

HeartStart Telemedicine Service Manager—Monitors the
Telemedicine inboxes. This service parses the data into separate
files and moves the data from the inbox into the database and a
backup folder.

•

The database—The database, installed when Telemedicine Server
software is installed, stores HeartStart MRx patient data (12-lead
reports, alerts, vitals, waveforms), configuration information, and
system log information.

This version of Telemedicine installs Microsoft SQL Server 2008 R2
Express Edition, which can store up to 10 GB of data in the database.
For information on how to estimate the number of days to save
patient data, see Data storage requirements on page.101.

Setting up the General Configuration area
Use the General Configurations work area to begin your configuration of
Telemedicine Server.
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The Server information area
On the Administration navigation pane, in General Configuration, the
HeartStart Telemedicine Server field shows the name of the HeartStart
Telemedicine Server database.

The Days to Save Patient Records area
The settings in the Days to Save Patient Records area determine how
many days of patient data that Telemedicine saves.
Also in this area is the Delete All button, used to delete all patient data
from your database.
To set up patient data history behavior
•

On the Administration navigation pane, in General
Configuration, in the Days to Save Patient Records area, in the
Previous History field, set the number of days you want to save
patient records in the database. The default number of days is 30.
For information on how to estimate the number of days, see Data
storage requirements on page.101.

To delete patient data from the database
•

On the Administration navigation pane, in General
Configuration, in the Days to Save Patient Records area, click
Delete All to delete all patient records from your database. For
more information, see Deleting patient data on page.67.
Telemedicine does not back up your database. Maintaining proper
backups is the database administrator's responsibility. Ensure that
your database administrator sets up appropriate database
management tools and checks that they execute successfully. See
Backing up your data on page.84.

The 12-lead report settings
The settings made in the 12-lead Report area of the General
Configuration workspace control how all 12-leads sent from
Telemedicine are formatted. For example, the settings will be used to
format 12-lead reports that you fax, or send from an Auto Send List.
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In the Report Preview window, the 12-lead Customization tab also
has settings for the formatting 12-leads. Those settings format only
the 12-lead report generated in that preview. All other 12-lead
formatting is controlled by the settings in General Configuration.

To set up 12-lead report format in General Configuration
1. On the Administration navigation pane, in General
Configuration, in the 12-lead report area, click Print with Grid
to print a grid in the 12-lead reports.
2. If you do not want a grid printed with 12-lead reports, clear Print
with Grid.
3. In 12-lead Layout menu, click a timing option. The default
selection is Time Sequential. The other option is Simultaneous.
•

Simultaneous 12-lead ECG Report marks each segment with
double vertical lines. It is the preferred 12-lead report format
used in the Europe.

•

Time Sequential 12-lead ECG Report marks each segment with a
single vertical line. It is the preferred 12-lead report format used
in the United States.
The default page size for 12-lead reports is “letter.” The other
option is A4. The Page Size settings are available in the View
menu, in 12-Lead, when the Patients navigation area is
selected. These settings control the format of the report, not the
printer paper selection.

For more about setting up 12-lead reports, see Working with 12-lead
reports on page.57, and Setting up for printing 12-lead reports on
page.111.

The Email settings
The way that Telemedicine Server works with email is set in the Email
area of the General Configuration workspace.
To set up email for Telemedicine Server
1. On the Administration navigation pane, in General
Configuration, in the Email area, in SMTP server name, type
the IP address or name of the email server. You can also configure
the optional user name, password, and port number, as well as using
the SSL appropriate with your SMTP server. Telemedicine uses this

88

4 - Administration of Telemedicine

HeartStart Telemedicine System User Guide

setting for emails that are sent through an Auto Send List.
The SMTP server can be installed on HeartStart Telemedicine Server
or another computer on the Intranet.
2. In Reply Email Address, type the return email address.
Telemedicine uses this setting for emails that are sent through an
Auto Send List.
3. Click Password Protect Attachment to manually send an email
attachment that is password-protected.
Telemedicine uses this setting when you manually send emails from
the File menu.
4. On the File menu or toolbar, click Save.

The Bluetooth settings
The Bluetooth Exchange folder location used by Telemedicine Server is
set in the Bluetooth field of the General Configuration workspace.
Although you can change the location for the Bluetooth Exchange
folder, do so only after careful planning and coordination within
your organization. Before you change the Bluetooth Exchange
Folder location in Telemedicine, change the Bluetooth Exchange
Folder location for your Bluetooth configuration.

To select a different Bluetooth Exchange folder location
1. On the Administration navigation pane, in General
Configuration, in the Bluetooth field, click Change....
A message appears, asking if you want to change the monitored
Bluetooth folder.
2. Click Yes to continue.
The Browse for Folder window opens.
3. Depending on your needs, either click an existing folder or make a
new folder. Click OK when you are done.
A message appears instructing you to restart your machine to use
the changed folder location.
4. Click OK to close the window.
5. On the File menu, click Save.
6. Restart your computer.
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To reset to the default Bluetooth Exchange folder location
1. On the Administration navigation pane, in General Configuration, in
the Bluetooth field, click Default.
A message appears, asking if you want to change the monitored
Bluetooth folder.
2. Click Yes to continue.
A message appears instructing you to restart your machine to use
the changed folder location.
3. Click OK to close the window.
4. On the File menu, click Save.
5. Restart your computer.

Starting the Telemedicine Service Manager
By default, Telemedicine Service Manager starts after Telemedicine
Server starts. The Telemedicine Service Manager can also run as a
Windows service. For more information, see Running Telemedicine
Service Manager as a service on page.102.
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HeartStart Telemedicine Bluetooth
Monitor
The HeartStart Telemedicine Bluetooth Monitor feature enables
Telemedicine to receive patient periodic clinical data transmissions
automatically.
In the default software installation, the HeartStart Telemedicine
Bluetooth Monitor feature starts when you start Telemedicine Server.
You can instead set up the Telemedicine Monitoring Service to
automatically start the HeartStart Telemedicine Bluetooth Monitor
feature when you log on to the Telemedicine Server computer (although
the Telemedicine Server software is not yet running).
You can stop the HeartStart Telemedicine Bluetooth Monitor feature at
any time.
To transfer the information from the defibrillator to Telemedicine
Server, you must set up the Bluetooth wireless data transmission on the
HeartStart MRx and the Telemedicine Server computer.
Install the Bluetooth software and adapter on the Telemedicine
Server computer with the Windows 7 operating system.
If the computer is not equipped with Bluetooth wireless technology, and
then the computer requires a Bluetooth dongle with an USB connector.
The Bluetooth dongle enables the Telemedicine computer to connect
with the defibrillator.
The HeartStart MRx with Bluetooth wireless technology can
communicate with nearby devices such as computers, laptops, tablets,
and mobile devices. Each device has a unique set of features and
configuration options. In order to ensure reliable transmissions,
familiarize yourself with the Bluetooth configuration choices of each.
Some Bluetooth configuration choices (either default or chosen by
the user) could prevent receipt of data from the HeartStart MRx.
For example, it is recommended that you disable features such as
“Start discovery every 10 minutes.” Enabling this option could
interfere with transmissions from the HeartStart MRx.
When the HeartStart MRx transmits data to Telemedicine, the
defibrillator creates subfolders on Telemedicine Server to store the
transmitted data.

91

4 - Administration of Telemedicine

HeartStart Telemedicine System User Guide

Bluetooth option prerequisites for the
HeartStart MRx
The Bluetooth card on the HeartStart MRx is inside of the defibrillator.
Make sure that you purchased the HeartStart MRx with the appropriate
Bluetooth option or upgrade.
For detailed information on setting up the MRx for Bluetooth wireless
transmission, see the following documentation:
•

HeartStart MRx M3535A/M3536A instructions for use

•

HeartStart data transmission implementation guide

Setting up the Bluetooth software and adapter
Install the Bluetooth software and adapter on the Telemedicine
Server computer with the Windows 7 operating system.
Setting up the Bluetooth software and adapter involves the following
tasks:
•

Installing the Bluetooth software and adapter

•

Pairing the HeartStart MRx Bluetooth with Telemedicine Server

•

Testing the connection

For other Bluetooth stacks, review your user documentation to see if
File Transfer Profile Server 1.1 is supported. If not, Philips recommends
that you install drivers that support File Transfer Profile Server 1.1.
During the following tasks, make sure that the defibrillator is within
Bluetooth transmission range, usually within 30 feet of the computer.
For information about installing the Bluetooth software and adapter,
refer to your Bluetooth software and adapter documentation.
The Bluetooth configuration creates the folder based on the logon of the
user who configured Bluetooth wireless communication. For example, if
you have the administrator logon, the default folder location is typically:
C:\Users\<user name>\My Documents\Bluetooth Exchange Folder.
If the user who receives the wireless transmission is not the
administrator, you can change the path to point to that user’s Bluetooth
exchange folder.
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For information about specifying the location of Bluetooth Exchange
folder, refer to your Bluetooth software and adapter documentation.
To pair the HeartStart MRx Bluetooth option with the computer
1. On the HeartStart MRx, place the defibrillator in the Data
Management mode.
2. On the Data Management menu, click Bluetooth Devices.
3. On the computer, set Bluetooth to be discoverable.
4. On the HeartStart MRx, scroll to Add Device and then press Enter.
The defibrillator searches for your computer.
If your computer is not listed after the search, your computer
Bluetooth is not enabled or set up correctly. Refer to your Bluetooth
documentation to troubleshoot the setup.
5. Select your computer and then press Enter.
6. Enter a passkey for the Bluetooth option.
The passkey is a user-defined character sequence, such as 000, or
1234.
See the documents listed in Bluetooth option prerequisites for the
HeartStart MRx on page.92.
7. In the notification area of the computer taskbar, immediately watch
for a pop-up message.
8. Click the pop-up message.
9. Type the same Bluetooth passkey that you entered on the HeartStart
MRx in Step 5.
The HeartStart MRx and the computer have a Bluetooth connection.
You are ready to test the Bluetooth connection.
10. On the Data Management menu, click File Transfer and then
press Enter.
The HeartStart MRx displays the "transmission test passed"
message.
11. Scroll to Exit and then press Enter.
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Using the HeartStart Telemedicine Bluetooth
Monitor
Use the Telemedicine Bluetooth Monitor feature to watch for patient
periodic clinical data transmissions that are received automatically from
the HeartStart MRx. The Bluetooth Monitor monitors the activity, stores
the data in the specified Bluetooth Exchange folder location, and imports
the data into the database.
Click the Bluetooth Monitor icon
in the Windows System tray to
display a message with the name of the feature and a status
message. (The system tray is located in the lower-right corner of
the Windows task bar.)
The Bluetooth Monitor feature of Telemedicine runs whether or not
your computer has Bluetooth wireless communication capability.
If you do not want to use Bluetooth monitoring, or if you do not have
Bluetooth capability, you can stop the Bluetooth Monitor feature.
To stop the Bluetooth Monitor feature
1. On the System tray, right-click the Bluetooth Monitor icon

.

A button appears next to the icon.
2. Click Exit HeartStart Telemedicine Bluetooth Monitor.
Telemedicine stops the Bluetooth Monitor feature and removes the
icon from the system tray. Telemedicine continues to run.
To start or restart the Bluetooth Monitor feature
•

From the Start menu, start Telemedicine.
Telemedicine starts Bluetooth Monitor, and the Bluetooth Monitor
icon

appears on the system tray.

To change the location of Bluetooth Exchange folder for
Bluetooth Monitor
You can change the location for the Bluetooth Exchange folder. Do
so only after careful planning and coordination with your
organization.
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1. Before you change the Bluetooth Exchange folder location in
Telemedicine, change the Bluetooth Exchange folder location for
your Bluetooth configuration.
2. On the Administration pane, click General Configuration.
3. In Bluetooth Exchange Folder, click >Change.
Telemedicine displays a message stating that the change will take
effect only after you restart the Telemedicine Server computer.
Respond to the message.
4. Navigate to the folder location, or click Make New Folder to create
a folder.
5. If you created a folder, rename the folder:
a. Right-click New Folder.
b. Click Rename and type a new name.
c. Click OK.
Telemedicine displays a message.
6. On the File menu or toolbar, click Save.
Follow your organizational and IT notification procedures to notify
Telemedicine users that you will restart the Telemedicine Server
computer.
7. Restart the Telemedicine Server computer.
To restore the default the Bluetooth Exchange folder location
You can restore the default the Bluetooth Exchange folder location.
Do so only after careful planning and coordination with your
organization.
1. Before you change the Bluetooth Exchange folder location in
Telemedicine, change the Bluetooth Exchange folder location for
your Bluetooth configuration.
2. On the Administration pane, click General Configuration.
3. In Bluetooth Exchange Folder, click Default.
Telemedicine displays a message stating that the change will take
effect only after you restart the Telemedicine Server computer.
Respond to the message.
4. Navigate to the folder location.
The default Bluetooth Exchange folder location is typically:
C:\Documents and Settings\<user name>\My Documents \Bluetooth
Exchange Folder
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Telemedicine displays a message.
5. On the File menu or toolbar, click Save.
Follow your organizational and IT notification procedures to notify
Telemedicine users that you will restart the Telemedicine Server
computer.
6. Restart the Telemedicine Server computer.

Sending the Bluetooth wireless transmission
You can download a 12-lead report to the computer through Bluetooth
wireless transmission while the HeartStart MRx is in the Data
Management mode, or while the HeartStart MRx monitors the patient’s
12-lead. For more information, see the appropriate chapters in
HeartStart MRx M3535A/M3536A instructions for use.

The Telemedicine Monitoring Service
This topic provides an overview of setting up a computer to support the
Telemedicine Monitoring Service.
The Telemedicine Monitoring Service has two subservices.
•

Telemedicine Web Service—Gets data from the Internet using
HTTP, and saves incoming data into the corresponding inbox
folder

•

Telemedicine Inbox Monitoring Service—Monitors all inbox
folders, and processes incoming data

Recommended security practices appear in the appropriate related
topics.
For more information about the HeartStart MRx data transmission
options, see Implementation supplement—Using Telemedicine with Data
Messenger on page.122 in this guide. Also see the HeartStart data
transmission implementation guide, which provides information about
implementing a complete data transmission solution. Contact customer
support to obtain the guide.

Setting up the Telemedicine Web Service
The HeartStart MRx communicates with Telemedicine through the
Internet.
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The Telemedicine Server computer requires the following services
before you can use Telemedicine to communicate with over the
Internet:
•

Internet Service Provider (ISP)
The ISP provides a connection to the Internet. The ISP must supply a
static or permanent IP address to support your domain name.

•

Domain Name Service (DNS)
The DNS provides a domain name for the IP address. Many ISPs can
obtain and register a domain name for you, or you can do it yourself.
For more information, see the Accredited Registrar Directory at the
InterNIC Web site (http://www.internic.net).

•

Internet Information Services (IIS)
The IIS sends and receives information from the Internet. Although
IIS ships with the Windows application, Windows does not
automatically install IIS when you install the operating system. You
must install IIS separately. See Enabling Internet Information
Services on page.97.

Enabling Internet Information Services
You must enable the IIS feature before installing the HeartStart
Telemedicine Server software. For more information, see Before
you install Telemedicine software on page.71.
More information about IIS is available from Microsoft.
When you enable IIS, the software automatically enables the default
features.
Enable IIS on your operating system
To enable IIS on Windows Server 2008 R2
1. From the Windows Start menu, click Server Manager.
2. In the Server Manager window, in the left pane, click Roles.
3. In the right pane, click Add Roles.
The Add Roles Wizard opens.
4. In the left pane, click Server Roles.
5. On the Select Server Roles page, in the Roles list, locate and
click Web Server (IIS).
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A dialog box prompts you to load the Windows Process
Activation Service.
6. Click Add Required Features.
The dialog box closes and returns to the Select Server Roles page.
7. In the left pane, click Web Server (IIS) and click Next.
The dialog box closes and returns to the Web Server (IIS) page
with the Roles Services option selected in the left pane. The Roles
Services list is in the right pane.
8. In the Roles services list, expand Application Development and
Common HTTP Features.
9. In the Application Development list, in addition to the default
features, verify that the following boxes are checked:
a. .NET Extensibility
b. ASP.NET
c. ISAPI Extensions
d. ISAPI Filters
10. In Common HTTP Features, verify that the following boxes are
checked:
•

Directory Browsing

•

Static Content

11. Click Next.
12. On the Confirm Installation Selections page, complete the
following:
a. Verify that Confirmation is selected in the left pane.
b. Verify that the wizard lists the selected features in the right
pane.
13. On the Installation Results page, click Close.
To enable IIS on Windows 7
1. From the Windows Start menu, click Control Panel, and then click
Programs.
2. On the Control Panel, in Programs and Features, click Turn
Windows Features on or off.
The Windows Features window lists the default features.
3. Expand the following items in the list: Internet Information
Services, World Wide Web Services, Application
Development Features, and Common HTTP Features.
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4. In Application Development Features, in addition to the default
features, verify that the following boxes are checked:
•

.NET Extensibility

•

ASP.NET

•

ISAPI Extensions

•

ISAPI Filters

5. In Common HTTP Features list, verify that the following boxes
are checked:
•

Directory Browsing

•

Static Content

6. Click OK.
Windows 7 enables IIS and displays the Control Panel Programs
window.
7. Close the Control Panel window.
Set up your firewall for IIS
To change Firewall settings
1. From the Windows Firewall window, on the left pane, click
Advanced settings.
The Windows Firewall with Advanced Security window opens.
2. On the left pane, click Inbound Rules, and then, on the right pane,
click New Rule.
The New Inbound Rule Wizard window opens.
3. In the Rule Type window of the wizard, under What type of rule
would you like to create?, click Port, and then click Next.
4. In the Protocol and Ports window of the wizard, under Does this
rule apply to TCP or UDP?, click TCP. Then, under Does this
rule apply to all local ports or specific local ports?, click
Specific local ports, type 80 in the field, and then click Next.
5. In the Action window of the wizard, under What action should be
taken when the connection matches the specified
conditions?, click Allow the connection, and then click Next.
6. In the Profile window of the wizard, under When does this rule
apply?, click Domain, click Private, click Public, and then click
Next.
7. In the Name window of the wizard, type a name for the rule in the
Name field, and then click Finish. The wizard closes.
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In the Windows Firewall with Advanced Security window, in the right
pane, under Actions, in Inbound Rules, the rule name appears.

Setting up the SMTP address
SMTP is used if you want to send email using an Auto Send List.
Philips recommends that you name an SMTP address on the General
Configuration workspace when you configure the Telemedicine Server.
You can install SMTP on the same computer as Telemedicine or on the
intranet.
For more information, see About Auto Send Lists on page.112.
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Data storage requirements
Data storage requirements depend on the volume and frequency of
patient transmissions, and on the type of data you send to Telemedicine.
This version of Telemedicine installs Microsoft SQL Server 2008 R2
Express Edition, which can store up to 10 GB of data, as the database.
Philips recommends that you adjust the number of days that
Telemedicine stores data on the General Configuration workspace
based on your network traffic.
• Telemedicine Classic 12-Lead Edition—Storage requirements depend
on the volume of 12-lead reports you send to Telemedicine. If you
assume that an average 12-lead report is approximately 45 KB, a
database with 10 GB capacity can store approximately 145,000 12-lead
reports (10 GB/45 KB =145,000, approximately).
• Telemedicine Critical Care Edition—Storage requirements depend on
the frequency of patient transmissions and the type of data you send to
Telemedicine.
The following table can help you estimate your data storage
requirements for Telemedicine Critical Care Edition. The data file sizes
are examples. Your actual data storage requirements will depend on the
size of your data files, and how frequently they are transmitted.
Use the table examples to estimate your storage requirements.
Transmission
interval for one
HeartStart MRx

Approximate
storage required
per month

1K

Assume that periodic
vitals are sent at 1minute intervals

0.22 GB

Trigger event

2K

Assume that a trigger
event is sent at 1minute intervals

0.44 GB

12-lead report

45 K

Assume that a 12-lead 2 GB
report is sent at 1minute intervals

Data to
transmit

Data in
kilobytes

Periodic vitals
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Running Telemedicine Service Manager as a
service
The default installation of Telemedicine transfers HeartStart MRx data to
Telemedicine only when a user is logged on and running Telemedicine.
If you need to receive HeartStart MRx data on a 24-hour/7-day
schedule, you must set up Telemedicine Service Manager. You can
configure the service from Windows.
To set up the service from Windows
1. Complete the normal installation of Telemedicine.
2. From the Windows Start menu, click Control Panel.
3. In the Control Panel window, double-click Administrative Tools.
4. Double-click Services.
5. In the Services window, click the Standard tab.
6. Right-click HeartStart Telemedicine Service Manager.
7. Click Properties.
8. In Startup Type on the General tab, click >Automatic.
9. On the Log On tab, in Log on as, click This Account.
•

The account must have administrator privileges on this
computer.

•

It must require a password.

•

If Telemedicine forwards 12-lead reports to a printer or fax, the
devices must be configured for this account.

If the Windows administrator password for this computer expires
and is changed, you must also change the administrator password
for the Telemedicine Service Manager.
10. Complete the account and password information.
11. Unless you have a specific reason, do not change the entries in the
Recovery or Dependencies tabs.
12. (Optional) If you want to start the service now, click the >General
tab and click Start.
13. Click OK.
14. Close the Services window.
15. Reboot the computer. The service will start.
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Configuring destinations
Telemedicine can access HeartStart MRx patient data from the
Telemedicine database and send it to one or more destinations. Patient
data from the HeartStart MRx can include 12-lead report, trigger event
and waveform, and periodic vital trend transmissions.
Use the appropriate option on the Administration navigation pane to
add, edit, and delete individual destinations.
To select a destination type to manage
1. On the navigation pane, click Administration.
2. On the Administration navigation pane, click a destination option:
•

Application Destinations

•

Fax Destinations

•

Email Destinations

Telemedicine displays the appropriate workspace for the type of
destination.

Setting up software applications as
destinations
This topic is for Telemedicine Server.
In Telemedicine, you can send a 12-lead report to another software
application.
Use the procedures in this topic to send 12-lead reports from the
HeartStart MRx to one or more of the following applications
automatically through an Auto Send List or manually from the Forward
Selected 12-Lead option.
•

HeartStart 12-Lead Transfer Station 3.0

•

TraceMasterVue

•

DatamedFT

•

Telemedicine

If you use the TraceMasterVue or DatamedFT destinations, check with
your sales representative to ensure that your version of these
applications are compatible with Telemedicine and the HeartStart MRx.
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Telemedicine can forward PCDT data to another Telemedicine
Server.
For more information, see How Telemedicine forwards HeartStart MRx
data on page.31, How Telemedicine forwards HeartStart MRx data on
page.31 and also Forwarding patient data on page.63.

Editing or deleting software application destinations
This topic is for Telemedicine Server.
Use the procedures in this topic to edit or delete software application
destinations.
In addition to sending data to printers or faxes, Telemedicine can send
data to other software applications.
The software applications that Telemedicine can see as destinations are:
•

TraceMasterVue

•

DatamedFT

•

HeartStart 12-Lead Transfer Station 3.0

•

Other instances of Telemedicine

The software application destination settings are managed in the
Application Destinations workspace. You can change the name,
description, type, and location of the destination. When you change the
fields in the Details area, Telemedicine updates the current destination.
To access the Application Destinations workspace
•

From the navigation area, click Administration, and then click
Application Destinations.

To edit a software application destination
1. On the Administration navigation pane, click Application
Destinations.
2. In the Application Destinations workspace, in the Summary
area, click a destination name.
3. In the Details area, change each setting that you want to edit.
4. On the File menu or toolbar, click Save.
Telemedicine updates the destinations in the Summary area.
5. Repeat these steps to edit another application destination.
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When you delete a software application destination, you remove the
destination from the Telemedicine database and Auto Send List.
To delete a software application destination
1. On the Application Destinations workspace, in the Summary
area, click a destination name.
2. On the File menu or toolbar, click Delete.
3. Click Yes to delete the destination or No to cancel the process.
Telemedicine updates the destinations in the Summary area.
4. Repeat these steps to delete another application destination.

Sending 12-lead reports to software applications
Use the Application Destinations workspace, available on the
Administration navigation pane, to set up another software application
as a destination for 12-lead reports. An application destination requires
a name and location.
To set up an application destination
1. On the Administration navigation pane, click Application
Destinations.
2. On the File menu or toolbar, click New.
3. On the Application Destinations workspace, in Name, type a
name for the application destination. For example, you might name
the destination “Rosenberg Hospital” or “Evergreen cath lab.”
4. In Description, you can type a brief description that describes the
use of the application.
5. In Location Type, click one of the following applications from the
list:
•

HeartStart 12-Lead Transfer Station

•

TraceMasterVue

•

DatamedFT (The DatamedFT software supports ECG hosts, such
as GE MUSE)

•

HeartStart Telemedicine

NOTE: The label of the next field (URL or Location) changes
depending on the application type that you select.
6. In the URL area, type the URL for the application. (If the field is
labeled Location, type the location.)
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The location can be where the application is installed, the network
address for the application, or the Internet address for the
application. Refer to the example to the right of the field for the
correct format.
If you click DatamedFT, type the location of the DatamedFT Inbox.
You can click Browse to navigate to the location of the DatamedFT
Inbox. For example: c:\DatamedFT\Inbound.
7. Click OK to add the location in the Location field.
8. On the File menu or toolbar, click Save to save the destination.
9. Repeat these steps to add more application destinations.
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Setting up fax destinations
In Telemedicine, you can manually send 12-Lead Reports to fax
machines. You can also set up an Auto Send List to send faxes.
Set up your fax using the fax settings in your Microsoft operating
system.

Fax option requirements
Before you can use the Fax feature in Telemedicine, complete the
following tasks:
•

Connect Telemedicine to a fax modem.

•

In Microsoft fax preferences, set the page size to letter, and the
page orientation to landscape.

•

For faxing from an Auto Send List, complete the fax settings using
the Auto Send Lists workspace.

Add, edit, or delete fax destinations
Use the procedures in this topic to add, edit, or delete fax destinations
for data.
To add a fax machine destination
1. On the navigation pane, click Administration.
The Administration navigation pane opens.
2. On the Administration navigation pane, click Fax Destinations.
3. In Name, type a name for the fax destination. For example, you
might name the destination “Rosenberg Hospital fax” or “Evergreen
cath lab fax.”
4. In Description, type a brief description that describes the use or
location of the fax machine.
5. In Fax number, type the phone number for the fax machine. Refer
to the sample phone format to the right of Fax Number.
6. On the File menu or toolbar, click Save.
7. Repeat these steps to add another fax machine to the Summary
area.
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You can change the name, fax number, and description for a fax
machine. When you change a field, Telemedicine updates the current
destination in the Summary area.
To edit a fax machine destination
1. On the Administration navigation pane, click Fax Destinations.
2. In the Fax Destinations workspace, in the Summary area, click a
destination name.
3. In the Details area, change each settings that you want to edit.
4. On the File menu or toolbar, click Save.
5. Repeat these steps to edit another fax machine destination.
When you delete a fax machine destination, you remove the destination
from the Telemedicine database and Auto Send List.
To delete a fax machine destination
1. On the Administration navigation pane, click Fax Destinations.
2. In the Fax Destinations workspace, in the Summary area, click a
destination name.
3. On the File menu or toolbar, click Delete.
4. Click Yes to delete the destination, or No to cancel the process.
5. Repeat these steps to delete another fax destination.
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Setting up email addresses as destinations
In Telemedicine, you can send a 12-lead report using the Email PDF
feature.
You can send 12-lead reports from the HeartStart MRx to one or more
email addresses automatically through an Auto Send List or manually
from the Forward Selected 12-Lead option.

Email requirements
Before you can use the Email feature in Telemedicine, complete the
following tasks:
•

Install the email application on the Telemedicine computer. For
more information, see the instructions for your email application.

•

If you want to email 12-lead reports through an Auto Send List,
install the SMTP server or relay for use with IIS. For more
information, see The Telemedicine Monitoring Service on page.96.

•

Configure the email settings on the General Configurations
workspace. For more information, see Setting up the General
Configuration area on page.86.

•

Complete the email settings using the Email Destinations workspace.
For more information, see Adding an email address to Email
Destinations on page.110.

Editing or deleting email addresses
Use the procedures in this topic to edit or delete email addresses in the
Email Destinations workspace.
To edit an email address destination
You can change the name, description, email address, and Auto Send
List name for an email address destination. You can also enable or
disable a password. When you change a field, Telemedicine updates the
current destination.
1. In the Administration navigation pane, click Email Destinations.
2. In the Email Destinations workspace, in the Summary area, click
a destination name.
3. On the Details area, change each settings that you want to edit.
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4. On the File menu or toolbar, click Save.
5. Repeat these steps to edit another Email destination.
To delete an email address destination
When you delete an email address destination, you remove the
destination from the Telemedicine database.
1. On the Administration navigation pane, click Email Destinations.
2. In the Email Destinations workspace, in the Summary area, click
a destination name.
3. On the File menu or toolbar, click Delete.
4. Click Yes to delete the destination, or No to cancel the process.
5. Repeat these steps to delete another Email destination.

Adding an email address to Email Destinations
Use the Auto Send Lists workspace to send 12-lead reports to one or
more email addresses. Telemedicine does not list email addresses that
you might have added to the email address book.
Use the Email Destinations workspace to add each email address to the
list in the Summary area. An email address destination requires a name
and an email address. You can also assign a password to the attached
12-lead report.
Be sure to tell the recipient the password that you assign to an
attachment in a separate communication or email.

To add an email address to the Email list
1. On the Administration navigation pane, click Email
Destinations.
The Email Destinations workspace appears.
2. On the File menu or toolbar, click New.
3. In Name, type a name that is associated for the email address. For
example, you might name the destination “Rosenberg Hospital
email” or “Evergreen cath lab email.”
4. In Description, you can type a brief description that describes the
use for the email address.
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5. In Add an email address, type the email address. Refer to the
sample format to the right of Add an email address.
6. To email password-protected 12-lead reports, click Password for
attachment, and type a password.
Telemedicine assigns the password to each 12-lead report that the
Auto Send List sends to this email address.
7. On the File menu or toolbar, click Save.
Telemedicine lists the destination in the Summary area.
8. Repeat these steps to add more email addresses.

Setting up for printing 12-lead reports
Prepare Telemedicine for printing 12-lead reports by doing the
following:
Set up for printing 12-leads in the Patients workspace
1. In the View menu, from 12-Lead, click Letter Page Size or A4
Page Size.
This selection ensures that 12-leads are formatted to appear
correctly and print in the selected page size. The default 12-Lead
View setting in Telemedicine is Letter Page Size.
2. In Windows and Telemedicine—Set up the default printer to work
with the Quick Print
button in the Report Preview window.
Test this to ensure that the setting works with the page size selected
for 12-leads (letter or A4).
3. In Windows and Telemedicine—Set up available printers to work
with the Print

button in the Report Preview window.

For information about previewing and setting options in 12-lead reports,
see Working with 12-lead reports on page.57.
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Setting Up Auto Send Lists
Set up the Auto Send Lists in Telemedicine after consulting with the
everyday users of Telemedicine to determine their needs for sending
data automatically.
This section is intended for IT personnel.
For Auto Send List information directed to everyday users, see Using
Auto Send Lists on page.65.

About Auto Send Lists
In Telemedicine, you can set up an Auto Send List to send a 12-lead
report to one or more destinations. This topic explains how
Telemedicine displays and works with Auto Send Lists.
You can save up to 50 Auto Send Lists. Each Auto Send List can
contain up to 20 destinations.
Auto Send List Summary
The Summary area, at the bottom of the Auto Send Lists workspace,
lists all the saved Auto Send Lists. When you click an Auto Send List in
this area, it appears in the Details area above.
Auto Send List Details
The Details area at the top of the Auto Send Lists workspace, shows the
name and description of the Auto Send List.
The name of the Auto Send List can be the user-assigned site name
of the HeartStart MRx hub.
The Destinations table, also in the Details area, shows the destinations
that are configured for the selected Auto Send List.
Default Auto Send List
Included in the Details area at the top of the Auto Send Lists workspace
is the Set as the Default Auto Send List checkbox. When this box is
checked, the displayed Auto Send List is the default Auto Send List. For
more information, see The default Auto Send List on page.65.
The HeartStart MRx can send a 12-lead report to one destination at
a time.
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An Auto Send List can send a 12-lead report to the following types of
destinations:
•

HeartStart 12-Lead Transfer Station 3.0

•

TraceMasterVue

•

DatamedFT

•

Telemedicine

•

Fax machine

•

Printer

•

Email address

How Telemedicine interacts with Auto Send Lists
•

If the HeartStart MRx hub name matches the name of a configured
Auto Send List, Telemedicine sends the 12-lead report to each
destination in that Auto Send List.

•

If the HeartStart MRx hub name does not match the name of a
configured Auto Send List, Telemedicine sends the 12-lead report to
each destination in the configured default Auto Send List.

•

If you do not configure a default Auto Send List, and the HeartStart
MRx hub does not match the configured Auto Send List, Telemedicine
adds the 12-lead report to the database.

Setting up email in an Auto Send List
If you want to send 12-lead reports in email using an Auto Send List,
Philips recommends that you name an SMTP address on the General
Configuration workspace when you configure the Telemedicine system.
The SMTP service delivers outgoing email messages. In most cases, you
can use the SMTP address supplied by your ISP or network.
You can use email as a notification service. Add an email address in the
default Auto Send List. Then, each time the application receives a 12lead from the HeartStart MRx, Telemedicine sends an email with a PDF
attachment of the 12-lead report to the email address in the Auto Send
List.
Microsoft provides an SMTP service. For more information, consult
Microsoft documentation.
Also, see Using Auto Send Lists on page.65.
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Creating a new Auto Send List
The Auto Send Lists workspace is available in the Administration
navigation area.
To create an Auto Send List
1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click Auto Send Lists.
3. On the File menu or toolbar, click New.
4. In Name, type a name. The HeartStart MRx can use this name when
specifying a destination.
5. In Description, type a brief description of the destinations for or
the use of the Auto Send List.
6. To use this Auto Send List as the default list, click the Set as the
Default Auto Send List checkbox.
7. In Destinations, click the name of each destination that you want
to add to the Auto Send List.
8. On the File menu or toolbar, click Save.
Telemedicine adds the Auto Send List in the Summary area.
To set the default Auto Send List
1. At the bottom of the Auto Send List workspace, in the Summary
area, click the list you want to set as the default Auto Send List.
2. At the top of the Auto Send Lists workspace, on the Details area,
click the Set as the Default Auto Send List checkbox, and then
click Save.
The displayed Auto Send List is assigned as the default Auto Send
List. To remove the assignment, clear the checkbox, and then click
Save.
If you occasionally send 12-lead reports to a specific destination, in
place of using an Auto Send List to direct your report, you can
instead use the appropriate option on the Administration navigation
pane to configure the destination. Once you configure it, the
destination appears in the Forward lists. The Forward option is
available on the File menu and toolbar.
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Editing or deleting Auto Send Lists
You can edit Auto Send Lists to add or remove destinations, or you can
delete Auto Send Lists.
You can rename the default Auto Send List from the HeartStart MRx
to a name of your choice.

To edit an Auto Send List
1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click Auto Send Lists.
The Auto Send Lists work area appears.
3. In the Summary area, click the name of the Auto Send List you
want to edit.
The name of the selected Auto Send List appears in the Details area,
in the Name field.
4. In the Details area, change the details you want to edit:
•

Click the Name field, and type your changes to the Auto Send
List name.

•

Click the Description field, and type your changes to the Auto
Send List description.

•

Click the Set as the Default Auto Send List checkbox to
assign this list as the default Auto Send List. Clear the checkbox
to remove the assignment.

5. In the Destinations area, add or remove a destination:
•

To add a destination to your Auto Send List—In Destinations,
click the checkbox for the destination you want to add.

•

To remove a destination from your Auto Send List—In
Destinations, clear the checkbox for the destination.

6. On the File menu or toolbar, click Save to save your changes.
Changes to name or description appear in the Summary area. The
default Auto Send List, if one is assigned, is marked in the Summary
area by a checkmark.
To delete an Auto Send List
1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click Auto Send Lists.
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The Auto Send Lists work area appears.
3. In the Summary area, click the name of the Auto Send List you
want to delete.
The name of the selected Auto Send List appears in the Details area,
in the Name field.
4. On the File menu or toolbar, click Delete.
A confirmation window appears.
5. Click Yes to delete the Auto Send List, or click No to cancel the
deletion.
6. Repeat steps 2 through 4 to delete additional Auto Send Lists.
7. On the File menu or toolbar, click Save to save your changes.
Deleted Auto Send Lists disappear from the Summary area.
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Configuring the Telemedicine Viewer
The Telemedicine Viewer provides a way for you to view patient data on
the Telemedicine Server from another computer. Telemedicine Viewer
is an optional component of the Telemedicine System. The Telemedicine
Viewer software is downloaded and licensed separately from the
Telemedicine Server software.
To configure the Telemedicine Viewer, you must perform tasks on the
Telemedicine Viewer computer and on the Telemedicine Server
computer.

Configure access to the Telemedicine Server database
The Telemedicine Viewer computer needs to communicate with the
Telemedicine Server computer. Use the following procedures to set up
the Telemedicine Server computer so that it can communicate with the
Telemedicine Viewer computer.
To open database TCP/IP access on the Telemedicine Server
1. On the Telemedicine Server computer, from the Windows Start
menu, click All Programs, and then click Microsoft SQL Server
2008 R2.
2. On the Microsoft SQL Server 2008 R2 list, click Configuration
Tools, and then click SQL Server Configuration Manager.
The SQL Server Configuration Manager window opens.
3. Click SQL Server Network Configuration and then click
Protocols for HEARTSTART.
4. Double-click TCP/IP.
The TCP/IP Properties window opens.
5. On the Protocol tab, under General, in the Enable field, click Yes.
6. Click the IP Addresses tab, and then scroll down to the IPALL
area.
7. In the IPALL list, click TCP Port to activate the text entry field to
the right.
8. In the text-entry field to the right of TCP Port, type 1433.
9. At the bottom of the TCP/IP Properties window, click OK to
accept your selection.

117

4 - Administration of Telemedicine

HeartStart Telemedicine System User Guide

A message appears, notifying you that the service will not be in
effect until you restart the computer.
10. Click OK to close the message window.
NOTE: The SQL Server Configuration Manager window should
still be open. If not, see step 2 to reopen it, and then return to this
step.
11. On the SQL Server Configuration Manager window, on the left
pane, click SQL Server Services.
12. From the list on the right, right-click SQL Server Browser and
click Properties.
The SQL Server Browser Properties window opens.
13. On the Service tab, under General, click Start Mode to activate
the menu to the right, and then click Automatic.
14. Click Apply to accept your selection, and then click OK.
The SQL Server Browser Properties window closes.
15. On the SQL Server Configuration Manager window, on the left
pane, click SQL Server Services
16. On the right pane, right-click SQL Server (HEARTSTART), and
then click Start, or Restart.
A message appears, informing you that the service is starting, or
restarting. A progress bar runs. When the process completes, the
message window closes.
17. Close the SQL Server Configuration Manager window.
18. Restart Telemedicine Server.
To configure the inbound TCP port on the Telemedicine Server
1. From the Windows Firewall window, on the left pane, click
Advanced settings.
The Windows Firewall with Advanced Security window opens.
2. On the left pane, click Inbound Rules; and then, on the right pane,
click New Rule.
The New Inbound Rule Wizard window opens.
3. In the Rule Type window of the wizard, under What Type of Rule
Would You Like to Create?, click Port, and then click Next.
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4. In the Protocol and Ports window of the wizard, under Does this
rule apply to TCP or UDP?, click TCP. Then, under Does This
Rule Apply to All Local Ports or Specific Local Ports?, click
Specific Local Ports, type 1433 in the field, and click Next.
5. In the Action window of the wizard, under What Action Should Be
Taken When the Connection Matches the Specified
Conditions?, click Allow the Connection, and then click Next.
6. In the Profile window of the wizard, under When Does This Rule
Apply?, click Domain, click Private, click Public, and then click
Next.
7. In the Name window of the wizard, type a name for the rule in the
Name field, and then click Finish. The wizard closes.
In the Windows Firewall with Advanced Security window, in the right
pane, under Actions, in Inbound Rules, the rule name appears.
To configure the inbound UDP port on the Telemedicine Server
1. From the Windows Firewall window, on the left pane, click
Advanced settings.
The Windows Firewall with Advanced Security window opens.
2. On the left pane, click Inbound Rules; and then, on the right pane,
click New Rule.
The New Inbound Rule Wizard window opens.
3. In the Rule Type window of the wizard, under What Type of Rule
Would You Like to Create?, click Port, and then click Next.
4. In the Protocol and Ports window of the wizard, under Does This
Rule Apply to TCP or UDP?, click UDP. Then, under Does This
Rule Apply to All Local Ports or Specific Local Ports?, click
Specific Local Ports, type 1434 in the field, and click Next.
5. In the Action window of the wizard, under What Action Should Be
Taken When the Connection Matches the Specified
Conditions?, click Allow the Connection, and then click Next.
6. In the Profile window of the wizard, under When Does This Rule
Apply?, click Domain, click Private, click Public, and then click
Next.
7. In the Name window of the wizard, type a name for the rule in the
name field, and then click Finish. The wizard closes.
In the Windows Firewall with Advanced Security window, in the right
pane, under Actions, in Inbound Rules, the rule name appears.
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Open the firewall on the Telemedicine Viewer computer
The Telemedicine Viewer computer firewall must be open for the
Telemedicine Viewer to communicate with the Telemedicine Server.
Follow these steps to set up each computer with Telemedicine
Viewer installed.

To configure the outbound TCP port on the Telemedicine
Viewer
1. From the Windows Firewall window, on the left pane, click
Advanced settings.
The Windows Firewall with Advanced Security window opens.
2. On the left pane, click Outbound Rules; and then, on the right
pane, click New Rule.
The New Outbound Rule Wizard window opens.
3. In the Rule Type window of the wizard, under What Type of Rule
Would You Like to Create?, click Port, and then click Next.
4. In the Protocol and Ports window of the wizard, under Does This
Rule Apply to TCP or UDP?, click TCP. Then, under Does This
Rule Apply to All Remote Ports or Specific Remote Ports?,
click Specific Remote Ports, type 1433 in the field, and then click
Next.
5. In the Action window of the wizard, under What Action Should Be
Taken When the Connection Matches the Specified
Conditions?, click Allow the Connection, and then click Next.
6. In the Profile window of the wizard, under When Does This Rule
Apply?, click Domain, click Private, click Public, and then click
Next.
7. In the Name window of the wizard, type a name for the rule in the
name field, and then click Finish. The wizard closes.
In the Windows Firewall with Advanced Security window, in the right
pane, under Actions, in Outbound Rules, the rule name appears.
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Connecting Telemedicine Viewer to
Telemedicine Server
You can connect Telemedicine Viewer to any available Telemedicine
Server.
At the bottom right of the Telemedicine Viewer window, the name of the
current Telemedicine Server appears in the HeartStart Telemedicine
Server field. For an illustration, see The Patients navigation area and
Patients workspace on page.37.
To connect Telemedicine Viewer to a Telemedicine Server
1. At the bottom right of the Telemedicine Viewer window, in the
HeartStart Telemedicine Server field, click Change Server....
The HeartStart Telemedicine Database Server window opens.
2. In the Database Server menu, navigate to the Telemedicine
Server you want.
3. Click OK to accept your selection and close the window.
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Implementation supplement—Using
Telemedicine with Data Messenger
The information in this section is a supplement to the HeartStart data
transmission implementation guide, Philips publication number
453564058751. Both documents are intended for IT personnel who are
setting up communication betweenHeartStart MRx Monitor/Defibrillators
and Telemedicine. If you are new to Telemedicine implementations,
review both documents before you begin.
For information about implementing data management solutions for
HeartStart products other than Telemedicine, see the HeartStart data
management solutions implementation guide.
Contact customer support to order the implementation guides.

Integrating Data Messenger and Telemedicine
HeartStart Data Messenger (Data Messenger) is a data transfer tool that
moves patient data from HeartStart MRx Monitor/Defibrillators
(HeartStart MRx) to a destination for review. Data Messenger can be
positioned between the HeartStart MRx and Telemedicine, enabling data
transfer capability that is not possible when transferring data directly
from the HeartStart MRx to Telemedicine.
•

Data Messenger can receive patient data from many HeartStart MRx
devices, and forward the data to Telemedicine automatically.

•

Data Messenger is available as a mobile device application: Data
Messenger Mobile Edition.
Note: The Mobile Edition is available as an addition to, not a
replacement for, the full version of the Data Messenger software.
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The following is an example of setups using both Data
Messenger and Telemedicine. Other setups are possible.

When you integrate Data Messenger with Telemedicine to forward
patient data over the Internet, Data Messenger can receive periodic
clinical data transmissions (PCDT) and 12-lead reports from the
HeartStart MRx. Data Messenger receives the data, and then uses HTTP
to forward the data automatically to Telemedicine across the Internet.
Telemedicine uses IIS to receive the files from the Internet.
If the computer that runs Data Messenger also hosts the mobile edition
of Data Messenger, then you can use a PocketPC or SmartPhone that
runs Windows Mobile 6 to run the mobile edition of Data Messenger. The
device must also be equipped with Bluetooth wireless technology, or
data-card access, in order to forward the HeartStart MRx to
Telemedicine.

Prerequisites
Complete the following before you connect Data Messenger and
Telemedicine:

123

4 - Administration of Telemedicine

HeartStart Telemedicine System User Guide

•

Install and configure a Telemedicine system.

•

Install Data Messenger on a computer that runs Microsoft Windows
7.

•

If the computer that runs Data Messenger hosts the mobile edition of
Data Messenger, install Windows Active-Sync. For more
information, see the “Using the Data Messenger Mobile Edition”
section in the HeartStart Data Messenger user guide.

Requirements and settings
The following settings are required for Data Messenger to transfer
HeartStart MRx periodic clinical data or 12-lead data to Telemedicine.
On the Telemedicine Server computer
If you need to receive HeartStart MRx data on a 24-hour/7-day
schedule, you must set up the Telemedicine Service Manager. You can
configure the service from Windows. For more information about
Telemedicine Service Manager, see Running Telemedicine Service
Manager as a service on page.102.
•

Verify that Telemedicine has access to the URL used by Data
Messenger for forwarding 12-lead and PCDT data.

•

Verify that the Telemedicine Service Manager is running.

•

If the firewall does not automatically open port 80 for HTTP
connections, create an exception for TCP port 80 in the Windows
Firewall of the computer running Telemedicine server.

•

For future reference, note your settings in a worksheet, such as the
one provided in the HeartStart data management solutions
implementation guide.

Troubleshooting Data Messenger and Telemedicine
Troubleshoot the transfer of data from HeartStart MRx through Data
Messenger to Telemedicine by testing the Bluetooth connection between
the HeartStart MRx and Data Messenger, and by testing the datatransfer connection between Data Messenger and Telemedicine.
Before testing, verify that your setup meets the following
requirements:
•

Data Messenger is set up to receive and forward HeartStart MRx 12lead reports and PCDT data. See the HeartStart Data Messenger user
guide for more information.
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•

Your HeartStart MRx version supports PCDT transmissions. See the
HeartStart MRx M3535A/M3536A instructions for use for more
information.

•

The HeartStart MRx is set up to send PCDT transmissions to Data
Messenger. See the HeartStart MRx M3535A/M3536A instructions for
use for more information.

•

The Bluetooth software and adapter is installed and set up on the
computer running Data Messenger.

•

The HeartStart MRx Bluetooth and the Data Messenger Bluetooth
have been paired.

Review the following troubleshooting questions, and if your answer is
no, complete the steps that follow the question.
Steps for troubleshooting
1. Did the HeartStart MRx transfer the PCDT data?
2. Did Data Messenger receive the PCDT data?
If not, do the following:
a. In Data Messenger, confirm that the Forward 12-Lead/PCDT data
box is checked on the Workflow tab of the Data Messenger
Configuration window.
b. In Data Messenger, confirm that the correct URL is entered for
Telemedicine in the 12-Lead or PCDT area on the Forward tab.
Click Verify to confirm the URL.
Data Messenger processes PCDT data automatically, regardless
of the mode that Data Messenger currently uses.
c. On the computer that runs Data Messenger, open the Data
Messenger Manual Process window and click the System Log tab.
d. Verify the data transfers on the System Log tab and look for
retries. Data Messenger stores verified data in the Bluetooth
folder.
e. Check the folder specified on the Workflow tab in the Failed area.
f. On the HeartStart MRx, confirm that the Data Messenger
computer appears as a transmission device. Pair the HeartStart
MRx with the Data Messenger computer again. For more
information, see the Configuring Data Messenger section in the
HeartStart Data Messenger user guide.
3. Did Telemedicine receive the PCDT data?
If not, do the following:
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a. On the HeartStart MRx, confirm that Telemedicine is set up as a
transmission destination. For more information, see the
HeartStart MRx M3535A/ M3536A instructions for use and the
Data transmission implementation guide.
b. In Telemedicine, confirm that the Telemedicine Service Manager
is running on the Telemedicine server computer.
c. On the computer that runs the Telemedicine server, confirm that
IIS is set up correctly and is running.

Troubleshooting the receiving and
forwarding of data
When patient data is not sent to its destination, first check the system
log for errors. For help using the system log, see Working with the
system log on page.69.
The information in this section is intended for use by IT personnel.
Use the following questions and instructions to guide you while
troubleshooting Telemedicine.

Are you connected to a database?
You can select the Telemedicine Server by name from your intranet.
Use the Telemedicine Server field in lower right corner of the
Telemedicine Viewer window to connect to a different Telemedicine
Server.
For more information, see Connecting Telemedicine Viewer to
Telemedicine Server on page.121.

Did the Telemedicine system receive the patient data?
1. On the Administration navigation pane, click System Log to
display the system log. Look in the log for the appropriate saved
message for the transmission, with the date and time when the
action occurred.
2. If the transmission was received, check the system log to see if
there are error messages for the transmission.
3. If the transmission was received and there are no messages, do one
of the following:
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•

If the transmission was a 12-lead report, see Does an Auto Send
List exist? on page.127.

•

If the transmission was a trigger event or periodic vital,
complete step 3 in Is the destination configured? on page.127.

4. If the transmission was not received, see Confirm that the Web
service is running on page.130 and Determine that the Telemedicine
services are running on page.130.
You can also review the following logs:
•

IIS log

•

IIS HTTP error logs

•

Microsoft logs that are available from Administration Tools on
the Control Panel window.

Does an Auto Send List exist?
If this is a destination other than one specified in the HeartStart MRx
routing file, you can configure an Auto Send List.
1. On the Administration navigation pane, click Auto Send Lists.
2. In the Auto Send Lists workspace, look in the Summary area to
confirm that an Auto Send List exists.
3. If an Auto Send List exists, continue with Is the Destination
Configured?
4. If an Auto Send List does not exist, configure one. For more
information, see Setting Up Auto Send Lists on page.112.

Is the destination configured?
You need to complete destination settings for all devices, whether they
are HeartStart MRx-specified or Telemedicine-specified.
Test each destination manually before you add the destination to an
Auto Send List.
Review the appropriate workspace that is accessible from the
Administration navigation pane.
1. On the Administration navigation, click the appropriate
destination.
2. If the destination is an application, click Application Destinations.
Telemedicine lists the configured application names in the
Summary area. See Is the destination TraceMasterVue or
Telemedicine? on page.129.
a. In the Summary area, locate the application name.
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b. If the application name does not identify the type of destination,
click the row and, in Location type, select the appropriate
application destination.
c. If the application name does not appear in the list, click New on
the File menu or toolbar to create a destination. See Setting up
software applications as destinations on page.103.
d. Confirm that the fields in the Details area are complete.
e. If the Applications Destinations workspace is complete, on
the File menu or toolbar, click Save.
3. If the destination is a fax, click Fax Destinations. Telemedicine
lists the configured fax machine names in the Summary area.
a. In the Summary area, locate the fax machine name.
b. If the fax name does not identify the fax number, click the row
and, in Fax Number, type the fax number. See Setting up fax
destinations on page.107.
c. If the fax name does not appear in the list, on the File menu or
toolbar, click New to create a fax destination. See Setting up
fax destinations on page.107.
d. Confirm that the fields in the Details area are complete.
e. If the Fax Destinations workspace is complete, click Save on
the File menu or toolbar.
4. If the destination is a printer, is that specific printer name in the list?
If not, configure the printer. See Setting up for printing 12-lead
reports on page.111.
5. If the destination is an email address, click Email Destinations.
Telemedicine lists the configured email addresses in the Summary
area.
a. In the Summary area, locate the email address.
b. If the email name does not identify the email address, click the
row and, in Add an Email Address, type the email address.
See Setting up email addresses as destinations on page.109.
c. If the email name does not appear in the list, click New on the
File menu or toolbar to create an email address destination. See
Setting up email addresses as destinations on page.109.
d. Confirm that the fields in the Details area are complete.
e. If the Email Destinations workspace is complete, on the File
menu or toolbar, click Save.
6. If the destination is an Auto Send List, click Auto Send Lists.
Telemedicine lists the configured Auto Send Lists in the Summary
area.
a. In the Summary area, click the Auto Send List name.
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b. In Destination, verify that the check box is selected for each
appropriate destination in the Auto Send List.
c. Click the destination row to add it to the Auto Send List, or, on
the File menu or toolbar, click New to create an Auto Send List.
See Setting Up Auto Send Lists on page.112.
d. If the Auto Send Lists workspace is complete, on the File menu
or toolbar, click Save.

Is the destination TraceMasterVue or Telemedicine?
If the destination is TraceMasterVue or Telemedicine, confirm the
following setup:
1. On the Administration navigation pane, click Application
Destinations.
2. In the Application Destinations workspace, confirm that the fields
in the Details area are complete.
If you need more information about the settings in the Location
Type and URL fields, contact the IT personnel at the receiving site.
3. If the Application Destinations workspace is complete, on the
File menu or toolbar, click Save.
If the previous steps did not solve the problem, the problem is probably
on the receiving end. Contact experienced IT personnel for the site and
request their help.

Is the destination DatamedFT?
If the destination is DatamedFT, confirm that the location is correct for
your installation. For example: C:\datamedFT\Inbound.
If the destination is correct, verify that a translated ECG was created in
the DatamedFT outbox.
If the previous steps did not solve the problem, the problem is probably
on the receiving end. Contact experienced IT personnel for their help to
troubleshoot the DatamedFT application or associated ECG host, such as
a GE MUSE application.

Is the destination a fax machine?
In the Windows Fax Console, confirm that the fax is set up.
Confirm with the receiving site that the fax is ready to receive.
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Is the destination a printer?
Confirm that the printer is ready to print.
•

Does it have paper?

•

Is it turned on?

•

Is the printer name spelled correctly?

•

Display the Windows Printer and Faxes window and confirm that
the status is READY.

Is the destination an email address?
Confirm that the email application or email service is installed or
configured for Telemedicine. In the General Configuration workspace,
confirm that the SMTP server address is correct. Contact the IT
personnel for the SMTP site and request their help.

Confirm that the Web service is running
Type the following URL in the browser Address field:
http://machinename/ems/MRxtest.mrx?SourceName=test
where "machinename" is the domain name or IP address of the
computer running Telemedicine.
If you see a test page with the product name and an image, then the
Web service is set up properly.
Otherwise, you will see an error message.
If the service is not running, restart IIS or check the IIS log to make
sure that the IIS is configured properly.
If the service is running and the 12-lead report was not received, the
problem might be the HeartStart MRx transmission, or the Inbox service
might not be running.

Determine that the Telemedicine services are running
On the Telemedicine Server computer, look in the Services window to
confirm that the Telemedicine service is running. The Services window
is located in the Windows Control Panel, in Administration Tools.
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Determine the source of the Inbox service error
Verify that the transmission reached the Inbox
To verify that the the transmission reached the Inbox
1. Navigate to the MRxInbox folder at the location specified in your
configuration.
2. If the 12-lead report is in the Inbox, the inbox server might not be
running.
See Verify that the Inbox service is running on page.131.
3. If there is no 12-lead report in the Inbox, the problem might be with
the HeartStart MRx transmission.
Verify that the Inbox service is running
To verify that the Inbox service is running
1. From the Windows Start menu, click Control Panel.
2. Double-click Administrative Tools.
3. Double-click Services.
4. Find Telemedicine Service Manager.
5. If the status is Stopped, right-click Transfer Station Service
Manager and click Start.
If the status is Started, then the problem is with the HeartStart MRx
transmission.

Clearing system log entries
You can remove the entire system log from the database. Philips
recommends that clearing entries from the system log should be done
only by experienced IT personnel.
When you back up your database, the system log is included in the
backup. For more information, see Backing up your data on
page.84.

To clear entries from the system log
•

On the File menu, click Clear System Log.
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System log messages
The system log provides a list of information and error system
messages for actions. Actions appear in the following table in
alphabetical order. Each message includes an explanation.
To troubleshoot an error message, use the following table to find the
error and action. Provide your IT personnel the information in the
Description and the Possible Issues and Solutions columns.

Log type

Action

Description

Possible issues and
solutions

Information Delete patient record

Deleted patient
record for Patient ID:
{Incident ID}

All received data for the patient
was successfully deleted.

Error

Failed to delete
patient record for
Patient ID: {Incident
ID}

Delete request failed. Possible
reasons for failure might be:

Delete patient record

Database connection failure
Another user might ave already
deleted the patient record.
Click Refresh.

Information Email 12-Lead

Error

Email 12-Lead

Information Email trigger event
report

Emailed 12-Lead
report for Patient ID:
{Incident ID} with
recorded time: {date
and time} to email
address: {email
address}, file name:
{file name}

The 12-lead report was
successfully sent to the email
queue.

Failed to email 12Lead for Patient ID:
{Incident ID} with
recorded time: {date
and time} to email
address: {email
address}, file name:
{file name}

Invalid 12-lead report. Possible
reasons for failure might be:

Emailed trigger event
report for Patient ID:
{Incident ID},
transmission ID:

The trigger event report was
successfully sent to the email
queue.
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client or the SMTP server for
blocked transmissions.

SMTP is not set up
Invalid 12-lead data
Missing Incident ID
Missing acquired date and time
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Email trigger event
report

Information Email patient record

Error

Email patient record

Information Email vital trends
report

Error

Email vital trends
report

Information Export trigger event
report
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Description

Possible issues and
solutions

{Transmission ID},
file name: {file
name}

Check the queue for the email
client or the SMTP server for
blocked transmissions.

Failed to email trigger The email client or SMTP server is
event report for
not set up.
Patient ID: {Incident
ID}, transmission ID:
{Transmission ID},
file name: {file
name}
Emailed patient
report for Patient ID:
{Incident ID}, file
name: {file name}

The patient report was
successfully sent to the email
queue.

Failed to email
patient report for
Patient ID: {Incident
ID}, file name: {file
name}

The email client or SMTP server is
not set up.

Emailed vital trends
report for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID},
file name: {file
name}

The patient vital trends report
was successfully sent to the
email queue.

Check the queue for the email
client or SMTP server for blocked
transmissions.

Check the queue for the email
client or the SMTP server for
blocked transmissions.

Failed to email Vital
The email client or SMTP server is
trends report for
not set up.
Patient ID: {Incident
ID}, transmission ID:
{Transmission ID},
file name: {file
name}
Exported trigger
event report. Patient
ID: {Incident ID}
transmission ID:
{transmission ID},
file name: {file
name}
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Log type

Action

Description

Error

Export patient report

Failed to export
patient report for
Patient ID: {Incident
ID}, file name: {file
name}

Possible issues and
solutions
Possible reasons for failure might
be:
Patient report failed to save.
The disk is full.
The path is no longer available.
The path does not have write
permission.

Information Export trigger event
report

Exported trigger
event report for
Patient ID: {Incident
ID} transmission ID:
{transmission ID},
file name: {file
name}

The trigger event report was
successfully saved in PDF format.

Error

Failed to export
trigger event report
for Patient ID:
{Incident ID},
transmission ID:
{transmission ID},
file name: {file
name}

Possible reasons for failure might
be:

Export trigger event
report

The trigger event report failed to
save.
The disk is full.
The path is no longer available.
The path does not have write
permission.

Information Export vital trends
report

Exported vital trends
report for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID},
file name: {file
name}

Successfully saved the patient
vital trends report in PDF format.

Error

Failed to export vital
trends report for
Patient ID: {Incident
ID}, transmission ID:
{Transmission ID},
file name: {file
name}

Possible reasons for failure might
be:

Database {Name} is
successfully migrated

Successfully migrated the
database (patient data and

Export vital trends
report

Information Migrate database
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Description

Possible issues and
solutions
configuration data) to the newer
installation of Telemedicine.

Error

Failed to migrate
database

Failed to migrate
patient data from
database server
{source name} to
{destination name}

The database migration was not
completed. Patient data failed to
transfer completely.

Error

Failed to migrate
database

Failed to migrate
configuration from
database server
{source name} to
{destination name}

The database migration was not
completed. Configuration data
failed to transfer completely.

Faxed 12-Lead for
Patient ID: {Incident
ID} with recorded
time: {date and
time} to fax number:
{Fax number}

The 12-lead report was
successfully sent to the FAX
queue.

Failed to fax for
Patient ID: {Incident
ID} with recorded
time: { date and time
} to fax number:
{Fax number}

Invalid 12-lead data. Possible
reasons for failure might be:

Printed 12-Lead for
Patient ID: {Incident
ID} with recorded
time: {Date and
Time} to printer
name: {printer
name}

The 12-lead report was
successfully sent to the printer
queue.

Failed to print 12Lead for Patient ID:
{Incident ID} with
recorded time: {Date
and Time} to printer
name: {printer
name}

Invalid 12-lead data. Possible
reasons for failure might be:

Printed patient report
for Patient ID:
{Incident ID} to
printer name:
{printer name}

The patient report was
successfully sent to the printer
queue.

Information Fax 12-Lead

Error

Fax 12-Lead

Information Print 12-Lead

Error

Print 12-Lead

Information Print patient report
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Description

Possible issues and
solutions
Check the queue for blocked
printer jobs.

Error

Print patient report

Information Print trigger event
report

Error

Print trigger event
report

Information Print vitals trend report

Error

Print vitals trend report

Information Save 12-Lead

Failed to print patient
report for Patient ID:
{Incident ID} to
printer name:
{printer name}

Possible reasons for failure might
be:

Printed trigger event
report for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID} to
printer name:
{printer name}

The trigger event report was
successfully sent to the printer
queue.

Failed to print trigger
event report for
Patient ID: {Incident
ID}, transmission ID:
{Transmission ID} to
printer name:
{printer name}

Possible reasons for failure might
be:

Printed vitals trend
report for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID} to
printer name:
{printer name}

The patient vital trends report
was successfully sent to the
printer queue.

Failed to print vitals
trend report for
Patient ID: {Incident
ID}, transmission ID:
{Transmission ID} to
printer name:
{printer name}

Possible reasons for failure might
be:

Saved 12-Lead for
Patient ID: {Incident
ID} with recorded
time: {Date and
time} imported from
{Source} file name:
{File name}

The 12-lead report was
successfully saved to database.
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printer jobs.
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Incident ID
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System uses Incident ID, Patient
ID, and acquired date and time
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Description

Possible issues and
solutions
to identify a duplicate ECG. If the
12-lead reports are duplicates,
the newly arrived 12-lead report
overwrites the older 12-lead
report.

Error

Save 12-Lead

Failed to save 12Lead. Missing Patient
ID: {Incident ID},
imported from file
name: {File name}

Possible reasons for failure might
be:
The 12-lead report is invalid.
The 12-lead report is missing an
Incident ID.
Note: All HeartStart MRx 12-lead
reports contain a valid Incident
ID, but 12-lead reports from
other devices might not.
Incident ID is required field for
use in HeartStart Telemedicine
System.

Error

Failed to save 12Lead. Missing
recorded time: {Data
and time} imported
from file name: {File
name}

Possible reasons for failure might
be:

Failed to save the
periodic clinical data
transmission

HeartStart Telemedicine Classic
12-Lead Edition does not support
periodic clinical data
transmissions.

Information Save trigger event

Saved trigger event
for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID}

The trigger event and associated
ECG successfully saved to
database.

Error

Failed to save trigger
event for Patient ID:
{Incident ID},
transmission ID:
{Transmission ID}

Possible reasons for failure might
be:

Error

Save 12-Lead

Save patient data

Save trigger event

The 12-lead report is invalid.
The 12-lead or missing the date
and time that 12-lead report was
acquired.

The trigger event might be
corrupted.
The trigger event is missing the
Incident ID or Transmission ID.
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Log type

Action

Description

Error

Save trigger event

Failed to save trigger
event, unsupported
MRx version:
{version number}
imported from file
name: {File name}

Possible issues and
solutions
The trigger event might be
generated from HeartStart MRx
version that is not supported by
HeartStart Telemedicine
System.

Information Save vital

Saved vital for Patient The patient vitals were saved to
ID: {Incident ID},
the database successfully.
transmission ID:
{Transmission ID}

Error

Failed to save vital for Possible reasons for failure might
IncidentID: {Incident be:
ID}, transmission ID:
The patient vitals might be
{Transmission ID}
corrupted.

Save vital

The patient record might be
missing the Incident ID or
Transmission ID.
Information Send 12-Lead

Sent 12-Lead for
The 12-lead report was saved
Patient ID: {Incident successfully to the destination
ID} with recorded
folder.
time: {Date and
Time} to application
name: {folder name}

Error

Failed to send 12Lead for Patient ID:
{Incident ID} with
recorded time: {Date
and Time} to
application name:
{folder name}

Possible reasons for failure might
be:

Information Send 12-Lead

Sent 12-Lead for
Patient ID: {Incident
ID} with recorded
time: {Date and
Time} to application
name: {URL}

The 12-lead report was sent
successfully to the destination
URL.

Error

Failed to connect to
application name:
{URL} for Patient ID:
{Incident ID} with
recorded time: {Date

Possible reasons for failure might
be:

Send 12-Lead

Send 12-Lead
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The disk is full.
The target folder is not accessible
or does not have write
permission.

The sender cannot access the
Internet.
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Description
and Time}

Possible issues and
solutions
The destination URL is not ready
to receive data.
If destination is either HeartStart
12-Lead Transfer System or
HeartStart Telemedicine, check
the test page
http://<domainName>/ems/
MRxPost.mrx?SourceName=test
where <domainName> is the
destination URL.
If image shows, the destination
is ready.

Error

Send 12-Lead

Rejected by
application name:
{URL} for Patient ID:
{Incident ID} with
recorded time: {Date
and Time}

Possible reasons for failure might
be:
TraceMasterVue rejected the 12lead report because the schema
validation failed.
Updated TraceMasterVue
software might be required to
support newer 12-lead report
schema.

Information Send patient data

Sent patient data for
Patient ID: {Incident
ID} to application
name: {URL}

Successfully sent patient data to
another HeartStart Telemedicine
System

Error

Failed to send patient
data for Patient ID:
{Incident ID} to
application name:
{URL}

Possible reasons for failure might
be:

Send patient data

The sender cannot access the
Internet.
The destination is not ready to
receive data.
Check the test page:
http://<domainName>/ems/
MRxPost.mrx?SourceName=test
where <domainName> is the
destination URL.
If image shows, the destination
is ready.

Information Start HeartStart
Telemedicine

Started HeartStart
Telemedicine
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HeartStart Telemedicine
successfully started HeartStart
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Action

Description

Possible issues and
solutions

Bluetooth Monitor

Bluetooth Monitor

Telemedicine Bluetooth Monitor.

Information Stop HeartStart
Telemedicine
Bluetooth Monitor

Stopped HeartStart
Telemedicine
Bluetooth Monitor

HeartStart Telemedicine
successfully stopped HeartStart
Telemedicine Bluetooth Monitor.

Information Start HeartStart
Telemedicine Service
Manager

Started HeartStart
Telemedicine Service
Manager

Windows successfully started
HeartStart Telemedicine Service
Manager.

Information Stop HeartStart
Telemedicine Service
Manager

Stopped HeartStart
Telemedicine Service
Manager

Windows successfully stopped
HeartStart Telemedicine Service
Manager.

Information Start
PDTSInboxMonitor

Started
PDTSInboxMonitor

HeartStart Telemedicine or
Windows successfully started
PDTSInboxMonitor.

Log type

Information StopPDTSInboxMonitor Sopped
PDTSInboxMonitor
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HeartStart Telemedicine or
Windows successfully stopped
PDTSInboxMonitor.

5
Customer support
Philips strives to provide you with excellent customer service and
technical support. Software updates for the integrated applications are
available from the application Help menu. From the Help menu, click
Check for Updates.
Customer support is available through email, Internet, and telephone.
Email product support is available in English only at:
telemedicine.support@philips.com.
Internet product support is available at the following address:
http://www.philips.com/DataManagementSupport
For telephone assistance outside the United States, call your sales
representative or local response center. See the following tables for
contact information. You can also navigate to technical support
telephone numbers for data management products at this address:
http://www.healthcare.philips.com/main/services/response_center
Region

Address

Telephone number

United States

Philips Healthcare
3000 Minuteman Road Andover,
Massachusetts 01810-1099

(800) 722.9377
(option 3)

Canada

Philips Healthcare, a Division of Philips
Electronics Ltd.
281 Hillmount Road
Markham, Ontario,
Canada L6C 2S3

(800) 291-6743

Authorized EU
Representative
Europe, Middle East,
and Africa

Philips Medizin Systeme
Boeblingen GmbH Cardiac and
Monitoring Systems Hewlett-Packard
Strasse 2
71034 Boeblingen, Germany

(+49) 7031 463-2254
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Region

Address

Telephone number

Latin America

Philips Medical Systems Ltda. Av. Dr.
Marcos Penteado Ulhôa Rodrigues,
401Parte 16 – 06460-040 –
Barueri/SP, Brazil

0800 7017789

Asia Pacific

Philips Electronics Hong Kong Ltd.
6/F, Core Building 1 1 Science Park
East Avenue Hong Kong Science Park
Shatin. New Territories, Hong Kong

+852 2821 5888

Philips Response Center telephone numbers
The following tables contain telephone numbers for Philips Response
Centers around the world.
North America

Telephone number

Canada

800-291-6743

United States of America

800-722-9377

Europe

Telephone number

European International Sales

41 22 354 6464

Austria

01 60 101 820

Belgium

French

02 525 68 80

Dutch

02 525 68 81

Finland

09- 615 80 400

France

0810 835 624

Germany

0180 3333 544

Italy

800 232100

Luxembourg

+32 2 525 68 80

Netherlands

040 27 85600

Portugal

800 201766

Spain

900 180612
902 304050

Sweden

08-59 85 2530

142

5 - Customer support

HeartStart Telemedicine System User Guide

Europe
Switzerland

Telephone number
German

0800 80 3000

French

0800 80 3001

United Kingdom

0870 532 9741

Asia and Pacific

Telephone number

Australia

1800 251 400

China

Beijing

800 810 0038

Hong Kong

852 2821 5888

Macau

853 0800 923

India

18004256788

Indonesia

021 794 7542

Japan

0120 381 557

Korea

080 372 7777
Seoul

02 3445 9010

Malaysia

1800 866 188

New Zealand

0800 251 400

Philippines

02 845 7875

Singapore

1800 PHILIPS
(1800-744-5477)

South Africa

011 471 6000

Thailand

02 614 3559

Taiwan

0800 005 616

Comments or suggestions?
Send your feedback and suggestions to:
telemedicine.support@philips.com.

Supported help
Customer support technicians provide help for the following:
•

Explaining the proper use of application features and answering your
questions about how the application works
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•

Explaining the proper installation and maintenance of the application

•

Assisting you in selecting and configuring card readers

Unsupported help
Customer support technicians do not provide help for the following:
•

Interpreting ECG or medical data. Call your medical director or
clinical specialist.

•

Repairing hardware. The support technicians can help you determine
if you have a hardware problem, but they cannot help you fix
problems that are not related to the Philips HeartStart application
software.

•

Troubleshooting defibrillators. Instead, call Philips Customer
Support and ask for defibrillator support.

•

Troubleshooting non-Philips products.

Helping us help you
You can help our technicians give you good support by following these
steps:
1. Call from a phone near your computer.
2. Start the software application.
3. Have the following information:
•

Windows version.

•

The application version number. This is available from the Help
menu. Click the About option.

•

A written copy of the error message text.

•

The activity and task you did when the error occurred.

144

Glossary
Bluetooth®
A short-range wireless technology that uses radio links between devices
such as defibrillators and computers, mobile computers, mobile phones,
and other portable devices.
Bluetooth wireless transmission
Use of a HeartStart MRx Bluetooth wireless technology transceiver
module to transfer a configuration from a HeartStart MRx defibrillator to
a Bluetooth-enabled computer.
DNS
Domain Name Service: provides a domain name for the IP address.
ECG
Stands for electrocardiogram. The electrical rhythm of the heart as
detected through defibrillator pads.
HeartStart MRx hub
A hub is a type of destination on the HeartStart MRx
Monitor/Defibrillators. It could be a fax, or a printer, or another
software application, such as TraceMasterVue. Each hub requires a
name. The hub on the HeartStart MRx is the equivalent to the
destination name on a Telemedicine Auto Send List.
HIPPA
The Health Insurance Portability and Accountability Act, a law passed by
the United States Congress in 1996.
HTTP
Hypertext Transfer Protocol is the set of rules for exchanging files (text,
graphic images, sound, video, and other multimedia files) on the
Internet.
IIS
Internet Information Services send and receive information from a
network.
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ISP
Internet service provider: provides a connection to the Internet.
PCDT
Periodic clinical data transmission, the patient data transmitted by the
HeartStart MRx Monitor/Defibrillators. PCDT can include 12-lead
reports, trigger events and waveforms, and periodic vital trends.
SSL
Secure Sockets Layer (SSL) is a cryptographic protocol that provides
communication security over the Internet.
System log
The system log lists all monitored application activity. Use the system
log to review application usage.
URL
Uniform resource locator. An address for a resource on the Internet.
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